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Introduction to this tutorial

The development cycle behind iSeries Projects involves creating and populating an
iSeries Project with source members. These members are then edited locally and
verified for syntax errors. Next, the members are pushed to the iSeries host and a
build is issued against them, depending on the Build Style associated with the
project. The errors from the compiles can be retrieved and viewed locally, and the
members can be modified accordingly. Finally, once all members compile error free,
they can be checked into a team server for source management, if team
development is required. The team server can be specified by associating the
project with a Team provider. The rest of this tutorial walks you through each of
these development steps, and applies them in the context of updating an existing
payroll application.

In this tutorial you will follow the typical iSeries” application development life
cycle tasks using a payroll application written in RPG or COBOL. You will work
through a series of exercises that will teach you about iSeries project based
application development.

Tutorial purpose:
Before you begin, take a minute to read the learning objectives for the
tutorial.

Length of time:
This tutorial takes approximately 1.5 hours to complete.

Modules:
Work on the modules in sequence. The pictures in the modules show
similar tasks. Some of the names and icons may be different from the
environment you will be working with when you complete the modules.

Prerequisites
You should also learn about the prerequisite knowledge for the tutorial
before beginning. This section describes the type of knowledge you need to
already have to fully benefit from this tutorial.

Learning objectives

In this tutorial, you will learn how to perform some typical iSeries native
development tasks. You will walk through a development cycle using iSeries
Projects where you are given the task of updating an existing payroll application
and re-pushing it back to the iSeries host. The development cycle involves creating
and populating an iSeries project with the existing code for the payroll application.
It then involves editing and verifying the code locally, and pushing it back to the
iSeries host. Finally, a build has to be submitted to the iSeries host to compile your
new and improved native application.

This tutorial is broken into ten modules, each with their own specific learning
objectives. Each module is composed of several exercises. These exercises must be
completed in order to successfully achieve the module’s goals.

The first module, Reviewing the 5250 payroll application, helps you learn about

the 5250 payroll application before you use the new iSeries Development tools to
maintain it.
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The second module, Starting Development Studio Client helps you learn about the
workbench and workspace. You will then learn how to start Development Studio
Client.

The third module, Opening a perspective helps you learn about a perspective, and
specifically the iSeries Projects perspective. You will then learn how to open the
iSeries Projects perspective.

The fourth module, Configuring a connection to an iSeries system and connecting
to an iSeries, explains how to create a connection to an iSeries server. You will
learn the steps to configure and create a connection.

The fifth module, Setting up an iSeries Project and enabling a merged view
describes how to create an iSeries project and to populate it with members. It also
explains how to show remote objects or local objects or both.

The sixth module, Editing source, helps you learn about some of the language
features available in the Remote Systems LPEX Editor while you edit ILE RPG
source or ILE COBOL source.

The seventh module, Verifying source, explains how to verify ILE RPG source or
ILE COBOL source in the Remote Systems LPEX Editor. You learn how to find and
fix errors identified in the iSeries Error list.

The eighth module, Building the iSeries Project, helps you learn how to select a
build style, submit a build and run the application.

The ninth module, Designing screens, helps you learn about the various aspects of
the CODE Designer while modifying a display file to add a screen.

The tenth module, Debugging a program, explains the Debug perspective and how
to start the debugger, set breakpoints, monitor variables, run and step into a
program, view the call stack in the Debug view, remove a breakpoint, add a
storage monitor, and set watch breakpoints.

Be sure to read about the Prerequisite knowledge for the tutorial before beginning.
This section describes the type of knowledge you need to already have to fully
benefit from this tutorial.

Prerequisite knowledge

vi

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* ILE RPG or ILE COBOL
* DDS

When you are ready to begin, start with the first module.

ILE RPG or ILE COBOL project-based application development



Chapter 1. Reviewing the 5250 payroll application

In this module, you are going to explore the application by invoking it from a 5250
session and working with the applications green screens and command keys.

You will learn about the 5250 application, before you start to use the new iSeries
Development tools to maintain it. This will allow you to become familiar with the
5250 screens and the behavior of the application.

Remember: Before beginning this module, you should learn about the Prerequisite
knowledge for the tutorial.

In order to review the 5250 order entry application, there are several steps you will
need to learn about and follow:

e Start the 5250 application
* Know what screens the application provides
* Know how the application works in its 5250 environment

* Know what command keys are supported and what functions they allow

In order to accomplish these learning objectives, there are several steps that are
involved, including:

e Starting the 5250 application
* Maintaining an employee record
* Maintaining a project record

* Maintaining a reason code
The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting the 5250 application

To start the order entry application you need a 5250 emulator on your workstation.

On the 5250 emulation screen on your desktop, displaying the sign-on screen:
1. Enter your User ID.
2. Enter your password.

3. On the command line of a 5250 screen, add the library RSELABXX to your
library list.

ADDLIBLE RSELABXX
4. Now, invoke the Payroll application:
CALL PAYROLL

The application starts and shows the first panel. This first screen asks you to
enter an X beside the application you want to maintain.

5. Choose the application that you want to maintain.

© Copyright IBM Corp. 2001, 2004 1



Maintaining an employee record

To maintain an employee record:
1. Type x beside Employee Master Maintenance.

e 1 Session A - [24 x 80] ! =10f x|

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] (%) 2 3| @

i =ctl

s

v | i menected to remote server/host toras pd101 on psprintl:pd101

Press Enter.

Type 123 for the Employee Number.

Type A for the Action Code to add employee 123.
Press Enter.

Type any information you like about the employee.
Press Enter.

Play in the employee records as much as you like.

© ® N ook Db

Press F4 to return to the maintenance selection.

Maintaining a project code

To maintain a project code:
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1.

2,
3.
4.

© © N o u

Type x beside Project Master Maintenance.

= I session A - [24 x 80] .
File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] % 2 3 @

(=]

| i :Ccnnected to remote server/host boras07m using port Z pd101 on psprintl:pd101

Press Enter.
Type 123 for the Project Code.
Type A for the Action Code to add project 123.

=1 Session A - [24 x 80] Bt
File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] % 2 3 @

(=]

E a
| i :Ccnnected to remote server/host toras07m using port 2 pd101 on psprintl:pd101

Press Enter.

Type any information you like about the project.
Press Enter.

Play in the project records as much as you like.
Press F4 to return to the maintenance selection.

Chapter 1. Reviewing the 5250 payroll application
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Maintaining a reason code

To maintain a reason code:

Type x beside Reason Code Master Maintenance.
Press Enter.

Type 123 for the Reason Code.

Type A for the Action Code to add reason code 123.
Press Enter.

Type any information you like about the reason code.
Press Enter.

Play in the reason codes as much as you like.

Press F3 to end the PAYROLL program.

© o Nk wDdNPRE

Recap

4

Congratulations! You have completed this module. You should now understand
how to:

* Start the payroll application
* Maintain an employee record
* Maintain a project code

* Maintain a reason code

* Exit the application.

You have reviewed all the panels in the payroll application. Continue to the next
module.

ILE RPG or ILE COBOL project-based application development



Chapter 2. Starting Development Studio Client

In this module you are introduced to workbench and the workspace. You then
learn how to start Development Studio Client..

In order to get started with Development Studio Client and the Remote System
Explorer, there are several steps you will need to learn about and follow:

* Explain workspace and workbench
* Start Development Studio Client

In order to accomplish these learning objectives, you are going to complete the
step: Starting Development Studio Client.

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting Development Studio Client

To start Development Studio Client:
1. Click Start on the task bar of your desktop

2. Select Programs > IBM® WebSphere® Studio > Development Studio Client
Advanced Edition for iSeries 5.1

@ Development Studio Client Advanced Edition for iSeries 5.1 »

&P Development Studio Client Advanced Edition For iSeries 5.

Note: If the Advanced Edition Version of the product is not installed on your
workstation then you will not see the words "Advanced Edition” in the
Start menu

3. A dialog may appear. Here you specify the name of the workspace where your
projects and other resources such as folders, subfolders and files that you are
developing in the workbench will reside.

WebSphere Studio il

WwiebSphere Studio stores wour work in a directory called a workspace. You can change the workspace each time
pou start WebSphere Studio. Specify the directomny to use for this session:

o ——
|D:\D|:nmmer|t3 and SettingshchnglmeiMy DocumentshBM \wds(\HS Elakbie J Browse... |

[ Use this workspace as the default and do not show this dislog box again

4. (Optional) Change the field in this dialog and use a unique directory name, for
example, RSElabXX (where XX is a unique number).

Note: If you have completed the tutorial called Maintaining an ILE RPG or ILE
COBOL application, then make sure that you use a different workspace.
Also make sure that you have restored the RSELABxx savefile to
overwrite changes made when you completed this other tutorial.
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5. Click OK to open the workbench.

cﬁ: Remote System Explorer - Welcome - WebSphere Develop tud - |E'I|_>_<_|
Fil= Edit Mavigate Search Project Run  Window Help
I-HE &8s -%-&%-|| || AAB||% -~
g Remot,..tems w» X x l Qutline X
ol N
X ¢ o o o |Development St...

& 4| An outline is
= = IThis page tells you what you should know before you= not available.
=N New C h Development Studio Client Advanced Edition for iSerie

T e tomnection and dlick on the related links.
CESAY Windows...
[+ £y Linuw, .. e
a ] @ Get started
[#]-Unix Unix, ., -
To know what ta do first, consult the Product Ov
#-B Local.. the information map in the online help ko decide F
] & iSeries. ., start using the product.
#-B Local
& Develop iSeries applications
‘fou can create and maintain RPG and COBOL apf
Learn more about the Remate System Explorer a _
< | LlJ
1) Remate System Details +E6d | & 2 & v x
K IR—— L |
Remote Systems | Team |
Properties * X
| E = B
Property I Value
1| | » | | Remote System Details |Tasks |iSeries Table View (iSeries Commands Log

The workbench refers to the desktop development environment. The workbench
aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources. Each workbench window contains one or more perspectives.

Checkpoint

Complete this checkpoint to determine if you are ready to move on to the next
module.

1. A workspace:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.
Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside

2. A workbench:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.
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d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.

e. Aand C

Recap

Congratulations! You have completed this module. You should now understand:
* The concepts of the workbench and the workspace
* How to start Development Studio Client

Now that you have started Development Studio Client, you can move on to
opening a perspective. Continue to the next module.

Chapter 2. Starting Development Studio Client 7
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Chapter 3. Opening a perspective

In this module you are introduced to a perspective. You then learn how to open a
perspective.

In order to open a perspective there are several steps you will need to learn about
and follow:

* Explain perspectives
* Describe the iSeries Projects perspective
* Open the iSeries Projects perspective

In order to accomplish these learning objectives, you are going to complete the
following steps:

* Introducing perspectives

* Opening the iSeries Projects perspective
The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Introducing a perspective

A perspective defines the initial set and layout of views in the Workbench window.
Within the window, each perspective shares the same set of editors. Each
perspective provides a set of capabilities aimed at accomplishing a specific type of
task or working with specific types of resources. For example, the Java"
perspective combines views that you would commonly use while editing Java
source files, while the Debug perspective contains views that you would use while
debugging Java programs. Perspectives contain views and editors and control what
appears in certain menus and tool bars.

Opening the iSeries Projects perspective

When you do iSeries project based development you will want to work in the
iSeries Projects perspective. This perspective serves two main purposes, namely for
performing iSeries offline development on Windows clients and for enabling team
development.

Offline development allows for a disconnected mode of development where a live
connection to a host is only required when code updates or builds are needed.

Team development is needed when code changes need to be shared between a
team of developers and synchronization of these changes is needed as part of the
development cycle.

Typically, you create local source physical files and members and edit them locally.
You can also download existing members from any remote library into your
project. Once done with the local editing, you can submit a build that will push all
your changes to the associated library of the iSeries Project and perform a build on
the remote members. The code pushed to this scratch library is only pushed there

© Copyright IBM Corp. 2001, 2004 9



for the purpose of performing that build. If source code management is needed,
the iSeries Project could be associated with any Team provider that is installed
with the Development Studio Client.

1. Click Window on the workbench menu.

Run | Window Help
_* »  MNew Window l.: -

Shows View 3
Hide Editors
Lock the Toolbars

& you start developing applications
iSeries. To get started, read the s

Customize Perspective. ..
Save Perspective As..,

2. Click Open Perspective > Other on the pop-up menu.
The Select Perspective dialog opens.
3. Select iSeries Projects.

[ select perspective S

B Component Test |-y
EQ_MI CYS Repositary Exploring
%Data
% Debug
ﬁ&InstaIl,l'Updete
iSeries Projects
29 j2ee
Java —
L Java Browsing
&Jjava Type Hierarchy
=0z Plug-in Development
@ Profiling and Logging _|

Darmnka Suckarn Fuvnlavar (Aafzolkhy

[ o« | concel [

4. Click OK.
The iSeries Projects perspective opens in the workbench.

Checkpoint
Complete this checkpoint to determine if you are ready to move on to the next
module.
1. A perspective:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.
Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders

and files that you are developing in the workbench will reside.
2. Match the perspective with its correct definition:

a. Combines views that you would commonly use while editing Java source
files
Contains views that you would use while debugging Java programs
Contains views that you would use while developing Web applications

10 ILE RPG or ILE COBOL project-based application development



d. Contains views that you would use while maintaining iSeries project based
applications.

Java perspective
Web perspective
Debug perspective

oo o

iSeries Projects perspective

3. In the Remote System Explorer perspective you can:
a. Display configured connections

Create a new connection

Connect and disconnect defined connections

Work with iSeries files, commands, jobs, IFS files

All of the above

® oo o

More practice

Want more practice? Try this!

Given your experience in opening the a perspective, open the Web perspective. See
a list of tools and views available to the Web developer. Next open the Java
perspective. See a list of tools and views available to the Java developer. Now since
you are supposedly in the Java perspective, open the Web perspective. Be careful
not to open another Web perspective.

Tip: Look in the workbench left-frame for the Web perspective icon. Now close
both the Java perspective and the Web perspective.

Recap

Congratulations! You have completed this module. You should know understand:
* The concept of a perspective

* The concept of the iSeries Projects perspective

* How to open the iSeries Projects perspective

Now that you have opened a perspective, you can move on to getting connected to
an iSeries system. Continue to the next module.

Chapter 3. Opening a perspective 11
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Chapter 4. Configuring a connection to an iSeries system and
connecting to an iSeries

In this module, you will create a connection to an iSeries server and select objects.
You will learn the steps to create a connection.

In order to configure and then connect, there are several steps you will need to
learn about and follow:

* Explain the Remote Systems view

* Configure a connection to an iSeries system

* Connect to an iSeries system

* Describe what you need to set up a connection
* Describe a profile

In order to accomplish these learning objectives, there are several steps involved,
including:

* Configuring a connection to an iSeries system

* Connecting to an iSeries system

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Configuring a connection to an iSeries system

When you first start the workbench and open a perspective, you are not connected
to any system except your local hard drive on your workstation. To connect to a
remote iSeries system, you need to define a connection. When you define a
connection, you specify the name or IP address of the remote system and you give
your connection a unique name that acts as a label in your workspace so that you
can easily connect and disconnect. When you connect to the iSeries system, the
workbench prompts you for your user ID and password on that host.

The first time you connect to an iSeries system, you need to define a profile.
Ok, let’s get started.

Remember, you have already opened the iSeries Projects perspective in the
previous module.

To configure a connection:

1. In the Remote Systems view, New Connection is automatically expanded to
show the various remote systems types you can connect to through the Remote

© Copyright IBM Corp. 2001, 2004 13



Systems view.

-4 Wwindaws...
m& Linux. ..
Fl-Unix Unix, ..

Remote Systems | Team

Expand iSeries to configure a connection to an iSeries system.

The Name personal profile page opens:

Mame personal profile

Uriquely name user profile !

‘Welcome to Remote Systems. Connections can be sharable by the team or private to
you, Enter a profile name to uniquely identify you From your beam members., You will
decide for each new connection whether it is owned by the team profile or vour
profile.

Profile: | FURICH

= Back Mext > Firrish I Cancel I

On this page of the New connection wizard and since it is the first time you
connect to an iSeries system, you need to define a profile. All connections,
filters, and filter pools belong to profiles. Profiles offer a way to group
connections, share connections, or keep them private, and they help you
partition data if you have a lot of connections or filter pools.

Your first profile will be for your local workstation. This is your personal
profile. You use this profile as you want to keep your connection private. You
do not want to share resources and information with other people.

2. Leave the Profile information default value. Click Next.

14  ILE RPG or ILE COBOL project-based application development



The Remote iSeries System Connection page opens:

Remote iSeries System Connection

Define connection information !

Parent profile: | VURICH =]

Connection name: | 54002

Host name: 54003 __D j

Description:

¥ Vetify host name

<Back | Next> [[ Finih | cancel [

On this second page you specify the information for your connection. The
cursor on this page is positioned in the Host Name field.

3. In the Host name field, type the name of your host system.

The Connection name is automatically filled with the host name. Leave it this
way. This name displays in your Remote Systems view and must be unique to
the profile.

4. Leave the Parent profile default value. You don’t need to change it. As the files
will be kept private the parent profile defaults to the default profile shown on
the previous page of the wizard. If you were sharing resources you would
select a team profile that you would have created earlier.

5. Leave the Verify host name check box selected.
6. Click Finish to define your system.

Connecting to an iSeries system

After you configure a connection to an iSeries system, you can easily connect and

expand your new connection to reveal your subsystems. Subsystems are a function

grouping of the various types of remote resources that can be explored in the

remote system. There are four subsystems:

* iSeries Objects is a PDM-like group, allowing access to libraries, objects and
members

* iSeries Commands allow you to predefine command sets each of which contain
one or more often used commands. When run, all commands in a command set
are sent to the remote system and executed, and the results are logged in the
Commands view

* iSeries Jobs allow you to see various jobs, subset by job attributes, and to
perform a limited number of operations on those jobs.

* IFS Files allow you to explore folders and files in the Integrated File System of
the remote iSeries system

Chapter 4. Configuring a connection to an iSeries system and connecting to an iSeries 15
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ITE Remote Sy v X
DeH @D i |::{ﬂ
B ,a\g Mew Connection
oA Windows,..
-0 Linux...
E-Unh Unix...
=B Local...
B--ﬁ iSeries...
i “¥] Connection created successfully, |
# B Local
=y s400a
SR - cts
C 5w Work with libraries. ..
[+ :%:b Waork with objects. ..
| = Work with members. ..
-
. [#-gip User lbraries
#-@k iSeries Commands
- iSeries Jobs
- Ty IFS Files
4] | >l
Remote Systems | Team

To connect to an iSeries system:

1. In the Remote Systems view, your new connection is expanded to reveal your

subsystems. The iSeries Objects subsystem is the subsystem you will use most

often! It is very similar to PDM, in that it allows you to access objects in the
QSYS file system, and perform actions on those objects.

2. Notice the first three entries under the iSeries Objects subsystem are named
after the PDM options, because they have similar capabilities:

* Work with libraries (similar to WRKLIBPDM)

* Work with objects (similar to WRKOBJPDM)

* Work with members (similar to WRKMBRPDM)
In addition there are entries for working with library lists and user libraries:

— Library list (to simulate PDMs WRKLIBPDM LIB(*LIBL) you can start
with the pre-defined Library list filter, that when expanded lists all
libraries in your library list.)

— User libraries
Now let’s work with a library in our library list.
3. Expand the Library list folder.

ILE RPG or ILE COBOL project-based application development



S

Now the connection will be activated and you will be prompted for a user ID

and password.

&b Enter Password

System type: | i5eries

Host name: | TORASO7M
Lser ID: I wdsclabOl
Password: | i

I Permanently change user 1D

[

Enter your user ID and password.

Select the Permanently change user ID check box.

Select the Save password check box.

Click OK.

Note: Make sure that your user ID has been setup, so that your library has
been added to the library list automatically. You can use the properties
for iSeries Objects dialog to set connection information such as adding a

library to a library list and changing the current library. You can

right-click on iSeries Objects then click Properties to see this dialog. You
will need this setup to run jobs interactively from your workstation.

&P Properties for iSeries Objects

Command Execution
- Environment Yariables

- Subsystem

Initial Library List

~Library list
|
Libra Library Position
RSELABXY (*FIRST )

Current lbrary: | *USRPRF =l
Inkialconmand;
(ICHGCLRLIBRSELAEKX J
Restore Defaults | apply |
| tké I Cancel I
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Back in the workbench you will see the libraries in your job’s library list.

_._“J Remote Syske —

2& @5’}_‘? Qo & ::U: ,;5'.':
I: N New Connection
: B & iSeries..
-] Connection created successfully
-t ,*g';' windows. ..
LD Linux..,
i [H-Unix Unix,.
I:I .E. Lcll:al

| »

Efn iSeries Objects

[ _'ﬁ"J ‘Work with libraries. .

:J _',—ﬂ,f' ‘Wiork with objects. ..

__| _ﬁb ‘wiork with members. ..

:I ﬁ» Library list

@il Qsvs.Mib.prod-sys
J {il, @svs2.#ib.prod-sys
J '}3 QHLPSYS, "‘lb prod-sys

&\ RSELABXX. i

a1l QGPL.*ib.prod-usr

=E 'h WRFLABXH, Mib, prod-usr
__| i—‘b User libraries
a* iSeries Commands

--ﬁ iSeties Jobs o=
4| | »

Notice that the s400a node now has a small green arrow in the icon to indicate
it is an active connection.

Also your RSELABXX library should have a small green star that indicates it is
the current library.

Note: If you do not see RSELABXX in your library list you can right-click on
the Library list and use the Add Library List Entry window to add
RSELABXX to your library list. If you also don’t see RSELABXX as the
current library you can right-click Library list and use the Change
Current Library window to change the current library to RSELABXX.

For each library, you can right-click and select from a number of actions. For
example, there is an action to create a new source file within the selected
library, to refresh the contents of the library if it is expanded, to rename the
library, copy the library or delete the library.

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. When you first start the workbench and open a perspective, you are not

connected to any system except your local workstation. To connect to a remote
iSeries system, you need to:

a. Start Remote System Explorer communication server
b. Start a 5250 session

C. Define a connection. Specify the name or IP address of a remote system
d. Define a profile

2. The first time you connect to an iSeries system, you need to define a:

a. Profile
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b. Filter
c. Filter pool
d. Connection
e. All of the above
3. Profiles:
a. Help partition data when you have a lot of connections or filter pools
b. Include all connections, filters, and filter pools
c. Group connections
d. Share connections

e. Keep connections private
f. All of the above
4. There are several types of profiles:
a. Team
b. Personal
c. Both
5. A team profile is used to share resources and information with other people. (T,
F)
6. Subsystems include:
a. iSeries Objects
b. iSeries Jobs
c. IFS Files
d. iSeries Commands
e. All of the above
7. iSeries objects include:
a. Work with libraries
b. Work with objects
c. Work with members
d. Library list
e. All of the above

More practice

Want more practice? Try this!

Given that you have access to your own iSeries systems, configure a new
connection and connect to this iSeries system. Now rename the connection, move
the connection up or change the attributes of the connection. Then use the iSeries
objects subsystem to list the libraries in your library list.

Use the Development Studio Client for iSeries online help to assist you in these
tasks.

Recap

Congratulations! You have completed this module. You should now understand:
* The concepts of profiles, subsystems, iSeries objects
* How to define connection information for an iSeries server
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* How to select the iSeries Objects subsystem and view the libraries in the library
list

Now that you have set up a connection, you are ready to create an iSeries project
and populate it with objects.

Continue with the next module.
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Chapter 5. Setting up an iSeries Project and enabling the
merged view

In this module, you will learn how to create an iSeries Project and import the
source you have just located for the green-screen application into that project. You
will also learn how to manage local and remote objects.

In order to create an iSeries Project and manage local and remote objects, there are
several steps you will need to learn about and follow:

* Describe iSeries Projects

* Create the iSeries Project

* Select the build style

¢ Populate the iSeries Project

* Show only local objects

¢ Show only remote objects

* Show both local and remote objects

* Recognize local and remote objects by their icons

In order to accomplish these learning objectives there are several steps involved,
including:

* Creating an iSeries Project

* Populating the iSeries Project

* Enabling the merged view

* Modifying the view to show local objects, remote objects or both
The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Creating an iSeries Project

iSeries Projects are projects that are dedicated for holding iSeries source members
destined to be pushed and compiled on an iSeries machine. They follow the
Workbench paradigm in that they have a special perspective, the iSeries Projects
Perspective, dedicated to showing and working with these projects. When a new
iSeries project is created three properties need to be associated with it. These are an
iSeries Connection, an Associated Library, and a Build Style.

Tip: Only iSeries projects can hold source physical files and members. Since you
can create various types of projects with the Development Studio Client for iSeries,
each project type is identified by a distinct icon. Specifically, iSeries projects are
distinguished by blue on the top right corner of the project icon.

Now that you have located the source code, you need to import it into an iSeries
project for editing. You can create a new iSeries project from scratch by using the
New iSeries Project Wizard.

To create an iSeries project:
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1. In the iSeries Project Navigator, right-click and click New > iSeries Project on
the pop-up menu.

Copy
E‘ Pasts E} iSeries Source Physical File
m q;-} iSeries Source Member
13 Export.. = Example...
W = Other...

iSeries Project Navigator |Mavigator  Bookmarks |

The iSeries Project page opens.

2. In the Project name field, type MyProject.

iSeries Project

Create a new iSeries project that maps to an iSeries library. E

Project name: I MyProject

Project conkents
¥ Use default

Direckary: | Di\WorkSpace_WDSCvS1\iSeriesProjTutoriakvS1\MyF Bitc

Specify the name and location of the iSeries project being created. An iSeries
project allows For local development, while performing builds on a remote iSeries
host machine.

<Bak [ mext> | Fiish | cancel |

3. Click Next.

4. Select your connection from the Connection list, for example, s400a.

The property iSeries connection allows for remote access to the iSeries host
machine, and handles various aspects, including user ID and password
authentication to the remote host. It also provides the initial environment for
builds, including the base library list.
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5. In the Associated library field, type RSELABxx

iSeries Project Properties

Specify the iSeries project properties.

Connection;

Associated i : | RSELABOL Browse. ..

x|
iz
) =] _ten. |
orome.. |

Specify the connection and library name to associate with this iSeries project. The
connection allows for remote access to the iSeries host machine, Code changes
made locally are pushed to the specified remote library, That library is also used far
performing builds on the remote host.

<Back | mwet> |[ Esh | cenca |

The associated library is a "scratch” library on the remote iSeries system that an
iSeries project maps to. It is used for pushing code changes made locally to the
remote host and for performing builds on that remote host. It is expected that
this library is a "personal” library and the goal is that there should not be any
need for any source in it to be edited directly on the host. It is meant to be a
sandbox in which a single developer can perform tasks.

6. Click Next.
7. Under Active build style, select CL Program.

iSeries Project Properties
Select and configure the active build style For this project. E

Active build style:

Configure. ..
Command LI
FMOME

This build style will upload CL programs specified in the configuration, compile thern,
and then run them to build this project. The compile commands can be automatically
generated,

Provided by 1BM plugin "iSeries Projects - Remote Build Stvles Plugin” version 5. 1.0

The property build style determines how a given iSeries Project is built. It
determines how source physical files and members are pushed to the remote
host, and how these members are compiled there.

8. Click Finish.
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This will create an empty iSeries project that you have to populate. This is
useful when you are creating new iSeries members from scratch and you don’t
have them already on a host.

Populating the project with members

24

You have an existing green screen application that you need to import into an
iSeries project. There are several ways of importing members into an iSeries
project, but the quickest way is to use the Make Available Offline action.

The Make Available Offline action downloads the selected files or members locally
to their corresponding iSeries project. The corresponding iSeries project has the
same host and the same library properties as the host name and the library of the
selected source physical files or members. If such an iSeries project is not found,
one will automatically be created. In your case, this action created a new iSeries
Project with the name being connectionName_libraryName. If there was one or
more existing iSeries projects which had the same connection and mapped to the
same library as the Associated Library, then this action would have prompted you
to select one of these existing projects.

To populate the project with members:

1. In the iSeries Projects perspective look for the Remote Systems view. It is
located under the iSeries Project Navigator.

2. In the Remote Systems View Library filter, right-click the QDDSSRC,
QRPGLESRC and QCBLLESRC source physical files and click Make Available
Offline on the pop-up menu.

; A ] Y B e

Ngh oo | Restore.,
I =12 PRIN User Actions 4
m-Eh m Add To [Series Project...
- E) QUL pureem—e
-y qom ==
=1 Ely QRPGLESRCP. *file.pf-src J
=-[E REFMST.*file.pf-dta Comme
&) [3 RSNMST, *file. pf-dta
@ MYCOMPILE.*cmd || Messac
Remote Systems |Propert'res Tasks

A dialog opens asking you to confirm the download of files to your project.

-ﬁa iSeries Projects Question ll

r"é; all source members of the selected source files will be downloaded locally and
. added to iSeries project MyProject, Proceed?

| Yes I No

3. Click Yes.
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The files will be added to your project:

= B iSeries Praject v X

G P
=1z MyPraject
1 5} QCBLLESRC
#-[E% qobssre
B RPGLESRC

iSeries Project Navigator ‘Navigatnr |Bookmarks

Enabling the merged view

Once the iSeries project has been created and populated with source files and
members, you can display the remote objects that exist in the associated library of
the project by selecting the Show Remote Objects action from the project pop-up
menu. This action displays the "bleed-through” view that merges all the local
resources with all the remote resources that exist in the remote library.

Now you want to display the "bleed-through” view that merges all the local
resources with all the remote resources that exist in the remote library.

To enable the merged view:
1. Right-click your project.
2. Click Show Remote Objects on the pop-up menu.

= & i5eries Frojec v X
SR =My Projec
E =8 QcEL New 3
e % QDDS Go Into
=-E% oree Open in New YWindow
Import Remote Objects. ..
Show Remote Objects
[ Copy
ﬁ Paste
# Delete
Move, ..
iSeries Project M Rename
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3. Your iSeries Project Navigator will now look like this:

= & iSeries Projec

SR~y Froject

4= QCBLLESRC (Local[Remote)
=-5f C (LocalfRemote)
w-Efj QRPGLESRC (LocaljRemate)

L Ef coMPARE *file.pf-src (Remote)
- [EF EMPMST *file pf-dta (Remote)
-2 EVFEVENT *file.pf-dta (Remote)
.68 MSTDSP, *file.dspf (Remote)
.6 M5TDSP2, *file,dspf (Remote)
- l!' PRIMST. *file.pf-dta (Remote)
5 QCLSRC*file.pf-src (Remote)
®-Ef QCMDSRC Hile.pf-src (Remate) |

iSeries Project Navigator | Mavigator |Bookmarks

Notice how some members are flagged with the yellow arrow. This shows that
there are objects that are local and remote.

Modifying the view

Next you modify the view to filter out remote objects.

To modify the view:

1. Go to the iSeries Project Navigator toolbar.

2. Click the drop down arrow.

3. Click Show > Remote Objects on the pop-up menu.

= @ iSeries Projec - X ”
Sort > |
I .o obiecs
. q: ) v Remate Objects
F @? QDDSSRC (LocalfRemate) <57 Link with Editor
-5 QRPGLESRC (Local/Remote) Expand &l
L [Ef coMPARE. *file.pf-src (Remote] Colanse sl
e [EF EMPMST. *file.pf-dta (Remote) 4, Collapse
- EVFEVENT *file pf-dta (Remote , oo LocaljRemate Flags
.6 MSTDSP, *file.dspf (Remote)
B¢ MSTDSP2, *flle.dspf (Remoate)
IR omeowmasT e of dbo P aeenk)

This removes all objects that are only remote from the view.

SR yFroject
= QUBLLESRC (Local/Remote)
1 5§ QDDSSRC (LacaliRemate)
5§ QRPGLESRC {LocalfRemate)

R

iSeries Project Navigator |Navigator | Bookmarks
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Recap

Congratulations! You have completed this module. You should know understand:

¢ The concept of an iSeries Project

* How to create an iSeries Project

* How to populate the iSeries Project with members
* The concept of a merged view

* How to enable a merged view

* How to view remote objects, local objects or both

Now that you have created an iSeries Project, populated it with members and
enabled the merged view continue to the next module.

Chapter 5. Setting up an iSeries Project and enabling the merged view
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Chapter 6. Editing Source

In this module, you will edit ILE RPG source member PAYROLL or ILE COBOL
source member PAYROLLC and learn about some of the Remote Systems LPEX
Editor’s language features.

In order to edit source, there are several steps you will need to learn about and
follow:

* Describe the features of the Remote Systems LPEX Editor
* Edit columns in RPG source

* Invoke SEU commands in the prefix area

* Undo and redo edit changes

* Invoke RPG programming language specific help

* Prompt for language specific information

* Indent RPG source

* Find and replace

* Filter source

* Find a string in multiple files with the search utility
¢ Compare two files with the compare utility

* Identify lines with syntax errors

* Correct syntax errors

In order to accomplish these learning objectives there are several steps involved,
including:

¢ Introducing the Editor

* Editing columns in RPG source

* Entering SEU commands

* Requesting Undo and Redo operations

* Invoking Language-Sensitive help

* Displaying COBOL line types

* Prompting RPG Language Specifications

* Indenting RPG source

 Finding and replacing text

* Filtering lines by string

* Searching multiple files

* Comparing file differences from the Remote Systems view
* Checking syntax

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin. You might want to maximize the Editor
window during this module.

Length of time:
This module will take approximately 20 minutes to complete.
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Introducing the editor

30

Your program editing tasks are simplified with the Remote Systems LPEX Editor.
The editor can access source files on your workstation or your iSeries system
directly. When a compilation results in errors, you can jump from the compiler
messages to an editor containing the source. The editor opens with the cursor
positioned at the offending source statements so that you can correct them.

Editing local source members under iSeries projects is the same as editing remote
source members in the Remote Systems Explorer. The LPEX editor can be launched
on any local member and the same functionality is available, such as the Outline
view, prompter and the code completion feature.

There is one major difference though when editing source members using the
LPEX editor in the Remote System Explorer perspective as opposed to using the
LPEX editor in the iSeries Project Perspective. When a source member is opened in
LPEX in the Remote System Explorer perspective, it is locked on the host, and it
cannot be modified on the host while the local edit session is in place. Any code
changes that you make locally will be pushed to the host when the Save action is
performed in the LPEX editor.

On the other hand, when a member is opened in LPEX in the iSeries Projects
perspective, the member is not locked on the host. It can be modified on the host
by anyone with enough authority to the library. If you do a Refresh on the iSeries
Project, a double sided red arrow will indicate that the member has been modified
on the host. If you perform a push action, you will be warned that you will be
overwriting remote changes, and you are given the chance to cancel the operation.

Here is a list of the some of the basic editor features that you would expect in a
workstation editor:

* Cut, copy, and paste

* Block marking of lines, characters, or rectangles with copy, move, and delete
operations

* Powerful find and replace function
* Unlimited undo and redo

In addition there are a few more functions that you may not have seen in a
workstation editor:

* Token highlighting where different language constructs are highlighted using
different colors and fonts to help identify them in a program

* SEU-like format-line rulers to show the purpose of each column for
column-sensitive languages like RPG and DDS. These rulers can automatically
update themselves to reflect the current specification.

* SEU-like specification prompting for RPG and DDS

* Sequence numbers, which allow SEU-style commands in the prefix area

* Intelligent tabbing between columns for column-sensitive languages

* Automatic uppercasing for languages that expect uppercase

¢ Settings for column-sensitive languages simplify text insertions and deletions
* On-line language reference

LPEX provides special support for insertion and deletion in column-sensitive
languages. When column sensitive editing is selected, each column is considered as
a separate entry space. For example, in an RPG source member, if you are inserting
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or deleting characters into a string that is in the Factor 2 entry, the Result field
entry does not move. The default editor preference is that column sensitive editing
is off. You can switch this support on by going to the workbench preferences
window. The LPEX Editor has predefined settings, but also has an associated
preference page containing settings that you can define. The name of the category
is LPEX Editor and it appears in the tree view of the Preferences window.

Now let’s try some of these features.

Opening a member in the iSeries Projects perspective

Now you are ready to open a member for edit in your iSeries Project.

To open a member to edit:

1. In the iSeries Projects Navigator, expand either QRPGLESRC if you want to
work with RPG source members or QCBLLESRC if you want to work with
COBOL source members.

= 6 iSeries Project v x

o o | @K

=1z MyProject
=1 5 QUELLESRC (LocaljRemate)

. note)
--[I¥ PAYROLLC2.CBLLE (LocalfRemate)
...[% PAYROLLD.CBLLE (Local/Remote)
1 5§ QDDSSRC (LocaljRemote)
=5 QRPGLESRC (Local/Remote)
I PAYRON. RPGLE (Local/Remote)
0% PAYROMNG.RPGLE {LocaliRemate)

iSeties Project Navigatar |Navigatur |Bookmarks

2. Double-click PAYROLL to edit RPG source or double-click PAYROLLC to edit
COBOL source.

The LPEX Editor opens with the selected member.

v x| /PAYROLLC.CBUE X 3 Outine X
& . Row 1 Column 1 Replace
NS Y TN, [N - NG NN, PGSR N JENSINIpRI W———, P
5 G MyProject e + 3 L IDENTIFICATI
1[5 QCBLLESRC (LocaliRemote) 000001 PROCESS APOST. il + ENVIRONMENT
[Bligd - vROLLC. CBLLE (LocaljRemote) 000002 [ DATA DIVISIO
| .7% PAYROLLC2.CBLLE (Local/Remote) || 000003 IDENTIFICATION DIVISION. ¥ PROCEDURE D
(% PAYROLLD.CBLLE (LocallRemcte) 000004
% (5§ QODSSRC (LocaRenote) 000005 PROGRAM-ID. PAYROLL.
=[5 QRPGLESRC (Local/Remote) 000006 AUTHOR. Programmer Na
© 2 PAYROLLRPGLE (LocallRemote) 000007 INSTALLATICH, IEM Toronto L
| P PAYROLLG.RPGLE (LocalRemote) 000008 DATE-WRITTEN. October 12, 1
) 000008 DATE-COMFILED. =
4 I »
iseries Project Navigator | | | 1 0

3. Double-click the tab to maximize the editor window.

Editing columns in RPG source

To edit columns:

1. Click Window > Preferences from the workbench menu.

Chapter 6. Editing Source 31



32

10.

The Preferences window opens.

&b preferences o = ]

(- Plug-In Development ﬁ LPEX Editor Parsers
[+ Profiling and Logging
+RAD [~ Show date area
- Readme Example @orumn sensitive editing
[=- Remote Systems
; - Communications
Files Signature |
[=1-{Series
- Cache Resequence start at {1-9999): | 100
) Ezzx:j Ez:::‘:; Resequence increment by (1-9999); | 100
- Job Subsystems [~ Resequence lines at save
9 &
El_ ;FLE].Z iglw i ®-|ighl'mht current line
[+ Program Verifiers Background -:dor
- Templates N —
Logging
- Passwords
[+ Server
- Spell Check
- Symptom Database
[+ Team
[+ UML Visualization —
Yalidation
[+ WAS Debug
[+ Web and XML Files -

1 | | » Restore Defaults | Apply I

I~ Add signature to changed lines

Irnpott... | Expart... | 0K | Cancel I

In the left pane of the Preferences window, expand Remote Systems.
Expand iSeries under Remote Systems.

Click LPEX Editor Parsers under iSeries.

The right pane allows you to set preferences for this feature.

In the right pane of the Preferences window, select the Column sensitive
editing check box.

When selected, each column is considered as a separate entry space.

In the right pane of the Preferences window, select the Highlight current line
check box.

This option highlights the line that the cursor is currently on. The option
applies to all source files opened in the editor area.

In the right pane of the Preferences window, click Background color.
The Color palette opens.

Select light yellow from the Color palette.

Click OK.

The Preferences window shows.

Other interesting preference settings are located under LPEX Editor Parsers.
When you expand this entry you see preference settings for the individual
language environments.

Click OK again on the Preferences window.
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Now let’s see what this does.

wekone | 71
(e 22)

..... en+LElen+AIDlevice+. Eeywords+++++++-
oozzoo F* used are - MITDSP - maintenance display file _:J
ooz300 F* - EMPMST - enployee master file 4
o0z 400 F* - PRIJMST - project master file
ooz 500 F* - RZINMST - reason code master file
002600 ) e oo e ol e il o e e e o ol e ol e e o o o o ol
o0z700 Fl‘IS'IiDSP CF E WORESTN
oozsoo0 FEMPMST UF AL E K DISK
oo0zs00 FFRIMST UF &4 E K DISE
003000 FRENMST UF & E E DISE
003100 D=
003200 D* Compile time array containing error descriptions
003300 I ERR 5 50 DIM(10) CTDATI
003400 D EMES3 35 50
003500 E®
DD3EUU C-x?:w:rx-xxwwx-xxw:x-xxr-.vxr.vx-xxrxxwxrxxwxrxxwﬁrx:wﬁr::wﬁ:v
«| | L|J
I

Return to the Editor window.

11. Move the cursor to line 27, column 10.

12. Make sure the editor is in Insert mode. If the status area shows Replace press
the Insert key.

13. Press the spacebar 3 times.

Notice that only the filename is shifted but none of the other columns to the
right are effected.

Owekone | Zmsose R x|

Row 27 Columrn 13 Inserc

..... FFilenaﬂe++1PEASFRlen+LKlen+AIDevice+.Keyuords+++++++—

o0zzoo F* used are - M3TDSF - mwaintenance display file _:J
ooz300 F* - EMPMST - enployes master file i
00z 400 F* - PRINST - project master file

00z500 F* - RINM3T - reason code master file
002600 F e I e O il ol e i i i ol i ol ol e o o e o o o
ooz700 w CF E WORESTN

oozgo00 FERTHS UF L E E DISE

oo0zs00 FFRIMST UF &4 E E DISE

003000 FRENMST UF &L E E DISE

003100 D=

003200 D* Compile time array containing error descriptions
003300 I ERR 3 50 DIM(10) CTDATI
003400 I EME3S 3 50

003500 E®

DDaEuU C-x?:x:rx-xxxwx-xxw-.vx-xxr-.vxr-.vx-xxrxxxxrxxwxrxxwﬁrxrxﬁrx:xﬁ:v
«| | LlJ
I

14. Press the Backspace 3 times.

Once again the filename is shifted but no other columns are effected.
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Entering SEU commands

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. Most editor profiles differ only in the keys
and commands used to perform various editor tasks. Some base editor profiles,
listed below, also add prefix information and command area at the start of each
line:

* ispf

* seu

* xedit

The editor recognizes prefix commands used by these editor profiles. Depending
on which profile you are using, you can enter SEU, XEDIT, or ISPF commands
when the prefix area is active.

If you are an SEU expert you will appreciate the ability to use SEU commands.

To enter SEU commands:

1. Move the cursor into the gray sequence number area to the left of the edit area
for PAYROLL or PAYROLLC.

Jwekome X | ZMSTDSP m X |

Fow 31 Column 1 Inserc 1 change.

B....... S T ST SR TR SR SN T DR T
oozzoo F* used are - MITDSP - maintenance display file :l
ooz300 F* - EMPMST - enployees master file s

4 F* - PRIJMST - project master file
F* - RESNM3T - reason code master file
) el ol el ol e il i el Ol i o ol e o o o ol
FMSTDSEF CF E WORESTI
FEMFMST UF L E E DISE
FFRIMST UF &4 E E DISE
FESNMST UF & E E DISE
D'ﬁ‘
D* Compile time array containing error descriptions
D ERR 5 50 DIM(10) CTDATI
003400 D EMESS 35 50
003500 E®
UDaEuU C-xxw:x-xxwwx-xxwwx-xxr-.vxrwxwxr:\-xwxrxxwxrx:wﬁrx:wﬁr::wﬁ:'
| | ’ |

2. On any sequence number type dd.

3. Go down a few lines and type dd again and press Enter.
Notice that the lines have been deleted.

4. Now type i5 in the sequence number area.

5. Make sure the cursor is within the sequence number area.

6. Press Enter.

Five new lines are inserted.

Requesting undo and redo operations

34

The editor records each set of changes you make to a file in the Editor window.
The number of changes made since the last file save is displayed on the status line.
If you want to undo a set of changes made to a file you use the Undo operation.
You can also cancel the effects of an Undo operation by using the Redo operation.
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Now you are going to undo some of the changes you just made to the file. Then
you will cancel the changes by using the Redo operation. Finally you will reload
the source so that it is back to its original form.

To undo and redo edit changes:

1. Select Edit > Undo from the workbench menu.
Notice that the 5 new lines disappear.

2. Press Ctrl+Z to undo the first change.
Notice that the deleted lines reappear.

3. Select Edit > Redo from the workbench menu.
Notice that the lines are deleted again.

At this point you will reload the source to make sure that it is back in its
original form.

4. Select File > Close option on the workbench menu.
A Save Resource dialog opens asking if you want to save the latest changes.

4P save Resource g x|

@ 'PAYROLL' has been modified. Save changes?

Yes Mo Cancel

5. Click No.

6. Go back to the workbench in the iSeries Projects perspective and open the
PAYROLL member in the QRPGLESRC file or the PAYROLLC member in the
QCBLLESRC file.

Invoking language-sensitive help

Inside the editor, there is cursor-sensitive language-reference help available. This
help is invaluable if you cannot remember the order of fields in an RPG

specification or the possible values for a variable field. This help is available from

the LPEX Editor window.

To receive language sensitive help, press F1 in an Edit window. If the cursor is on
an operation code, you receive help for that operation code; otherwise, you receive

help for the current specification.

To access language sensitive help:

1. Position the cursor over the word MOVE in line 112 of the ILE RPG source or
231 in the ILE COBOL source.

2. Press F1.

Language-sensitive help for the MOVE operation code appears in a Help
window.
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Text marked in blue in the Help window contains the link to detailed
information about the topic in blue.

4b Help - WebSphere Development Studio Client Advanced Edition foris - |D|ﬁ
Szarch: | |m Search scope: All kopics
Contents @ || iSeries programming information fe Bl S
B M (Rettieve a»—':-l =l
) ITER (terate) MOVE (Move) [
B KFLD (Define F
g E;SJEC([;ZK Free-Form |(not allowed - use the EVALR operation
B) LEAYESR (Lexr Syntax code, or built-in functions such as %
B LOOKUP (Look DATE, %TIME, %TIMESTAMP, %CHAR,
Bl MHHZO (Move %BUCSZ, or %GRAPH)
Bl MHLZO (Move
Bl MLHZO (Move
B mLLZO (Move Result
[ MONITOR (Bes Code | Factor1 Factor 2 Field |Indicators
i MOVE |Data Source field Target
Wwoveatmove || @) |Attributes field

B MOVEL (Mave
B MuLT {Multiply__
B MyR (Move Re
Bl WEXT (Next)

Bl 0CCUR (Setjc
B ON-ERROR (O
B OPEM (OpenF
B orxx (O

B OTHER (Other
B ouT (Write a [
Er parM (Identif-
B pLIsT (Identlﬁ -

l|~9|ﬁ|ﬂﬂ

The MOWE operation transfers characters from factor 2 to
the result field. Moving starts with the rightmost character
of factor 2.

When moving Date, Time or Timestamp data, factor 1
must be blank unless either the source or the target is a
character or numeric field.

Otherwise, factor 1 contains the date or time format
compatible with the character or nurmeric ﬂeld that is the
source or target of the operg#th, For inform

formats that can be used ske Date Data Type,
Tune and Timastaran Nata
4
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4P Help - WebSphere Development Studio Client Advanced Edition foriSeries

Szarch: | |m Search scope: All kopics

Contents @ || iSeries programminginformat = o ¥ | &
=Bnzrecrsaer=! Dayelopment Studio:
(2 MERGE Statemer

EI'® 10VE Statemen
B MOVE Stater
B MOVE Stater
B MOVE Stater
B Elementary |
B Group Move
B WHEN-COMI
® (2 MULTIPLY Stater
(3 opeN Statement
L2 PERFORM Stater
(2 reaD statement
1 RELEASE Staterr
® (B RETURN Statern
(2 REWRITE Stater
B ROLLBACK State
w# L2 sEaRCH Statem
(1 seT statement
3 soRT Statement
3 sTART Statemer_|
(3 sToP statement
w# L2 STRING Stateme
(3 sUBTRACT State
(3 UNSTRING State
L2 wRITE Statemer

® [ Intrinsic Functions ¥
0 | »

B | ¥

I

ILE COBOL Reference

MOVE Statement

The MOVE statement transfers data between
areas of storage.

The MOWE statement has two formats:

< T
e Format 2 - MOWE CORRESPOMNDIMNG

Related Information:

o MOWE Staternent Rules

e Elementary Moves

o Group Moves

o WHEN-COMPILED Special Register

[ Top of Page | Previous Page | Next Page |
Table of Contents ]

Copyright 1B Corporation 1992, 2003, All Rights
Reserved,

COBOL help.

3. Click the link Date Data Type for the RPG help or Format 1-MOVE for

Chapter 6. Editing Source

37



4. Click the Show in Table of Contents icon on the Help window toolbar.

db Help - webSphere Development Studio Client Advanced Editi

=10/ x]

|m Search scope: All topics

iSeries programming information

P Y
& @(ﬁ)l =Y

Search: |
Contents o)
-
) -l

quage Reference

Conkents
RPG IV Concepts
Definitions
h Defining Data and Pro
b3 Using &rrays and Tabl
= Types and Data
(5 1rternal and Exter
(3 character Data T:
L2 numeric Data Typ
B8 Date Data Type
B separators
B Initiglization
# 3 Time Data Type b

Date Data Type A

Date fields have a predetermined size and format. They
can be defined on the definition specification. Leading and
trailing zeros are required for all date data.

Date constants or variables used in comparisons or
assignments do not have to be in the same format or use
the same separators. Also, dates used for I/O operations
such as input fields, output fields or key fields are also
converted (if required) to the necessary format for the
aperation.

The default internal format for date variables is *1S0, This
default internal format can be overridden globally by the
contral specification keyword DATFMT and individually by
the definition specification keyword DATFMT.

The hierarchy used when determining the internal date

farmat and separator for a date field is
18] Timestamp Data T P

(2 object Data Type 1. From the DATFMT keyword specified on the
£ Basing Painter Dal definition specification
B procedure Painter 2. From the DATFMT keyword specified on the
(2 patabase Mull Yal control specification
[ Error Handling for 3. Ms0
o () Editing Numeric Fields _ || There are three kinds of date data formats, depending on
e | » the range of years that can be represented. This leads to
= y r thae naccihility of a data avadlowe ar nndadflaswe canditinn hal
| 5 & | ) 4|" ;IJ
4P Help - WebSphere Development Studio Client Advanced Edition | =]
Search: | |m Search scope: All topics
Contents @3 || iSeries programming informa 2 o (E%‘j I &
ST - o~ .
39@”"55“* Development Studio:
amoesas | |LE COBOL Reference
[l MOVE State
B Elementary
B Group Move MOVE Statement - Format 1
B WHEN-COM
[+ Q;IMLI_TIPLV State HOVE Statement — Format 1
® L3 opem Statemen —
 H2 PERFORM State v
# L3 READ Statemen > »=MOVE——+—-JFan 1 frar—t-+—=T0————_
—fitmrai-t—r
B RELEASE Staten— -
® L2 RETURN Statem
w 2 REWRITE Stater
B ROLLBACK State
& 03 sEaRCH Statem [Top of Page | Previous Page | Next Page
@ [ g7 seatement |l | 12ble of Contents | |
J | 5 . T
“opyright IEM Corporation 1932, 2003, All Rights -
8 [ v | 5 | @ |4 I by~

This will synchronize the topics in the Contents pane on the left to the help
topic you are viewing in the main help pane.

5. Play around in the Help window to see what else is available.

6. Minimize the Help window.

7. Select Help > Help Contents on the workbench menu to see a list of all help
that is available in the product.
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10.
11.
12.

Here you will find the table of contents and you can select a topic of interest.

4P Help - webSphere Development Studio Client Advanced

Search: | |m Search scope: All kopics
Contents (<o)
Q iSerj

L iSeries programming information
mmmm
@ Support information

Q Tool developer information

©: J2EE SDK 1.3.1 APIs

@ Remote System Explorer User Guic
@ 125E SDK 1.3.1 APIs

@ websphere Application Server Net
Q Application developer information
@ Rational ClearCase

< I 2|

g | v, # @

Using Eclipse help system

Browse topics in the Contents frame () on th
Click on topics to display them. Use the Back :
Forward buttons to navigate within history of vi
topics.

Searching

To quickly locate topics on particular subject in
entire docurnentation set, enter a query in the S

field. Click (%) icon to display Search view. Yo
narrow scope of the search by selecting only s
that you are interested in.

Synchronizing

After you run a search and find a topic you were
for, click the Synchronize button (E] to matct
navigation tree up with the current topic. You m

find it useful to synchronize after following in-tog

4 | »

In the left pane of the Help window, click iSeries programming information.

Expand High level languages.

Expand ILE RPG or ILE COBOL.

Expand Programming Guide.
Expand Contents.
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13. Click About This Guide.

db Help - webSphere Development Studio Client Advanced Editi - iS -10] x|
Search: | |m Search scope: Al bopics
Contents @ || iSeries programming informa <= o 1 | &
. . . . . r
Q iSeries application developer in— We bs p h ere
!| iSeries programming informatii .
() High-level languages Development Studio:
B PDF versions of the books '
B cicis ILE RPG Programmer's
® L3 cosol 400 Guide
= [3 1Le coBoL
B Java
= [ regj400 About This Guide
G ueres
@ L2 Language Reference This guide provides information that shows
G2 Programming Guide how to use the ILE RPG compiler (ILE RPG)
Contents in the Integrated Language Environment. ILE
& A - T RPG is an implementation of the RPG IV
= About This Guide | he iSern ith th
08 1LE RPG Introduction anguage on the iSeries server with the
& . . Operating System/400 (0S/400) operating
# (8 creating and Running system. Use this guide to create and run ILE
® 9 pebugging and Excep applications from RPG IV source.
@ £ vorking with Files anc This auide sh haw ta: |-
® 00 Appendixes is guide shows how to:
= L2 pata Definition documentation e Enter RPG IV source statements
& 3 control languaage information . C!’E ate modules
Q Remote System Explorer Devel » Bind modules
@ support information * Runan ILE program
s _lll o Call other objects
d | X « Debug an ILE program
] l ¥ & | « Handle exceptions ~|
4P Help - webSphere Development Studie Client Advanced Edition foriSerie =]
Szarch: | |m Search scope: All topics
Contents t%a iSeries programming informatic o o féz I &
- . . - L . ;
Q iSeries application developer in— Deve I o) p me nt St u d io:
‘J iSeries programming informatic
@QHil;h-level languages ILE CO BOL
& POF versions of the books ' .
D@ it Programmer's Guide
® L3 cosovy400
(B8 1e cosoL i .
Bq;lLanguageReference About ThIS Gl.“de
Programming Guide — . . . : - =
@Cmtents R; This guide describes how to write, compile,
B what's New bind, run, debug, and maintain Integrated
\& - = Language Emdronment (ILE) COBOL compiler
CR8 About T de g
e — programs on Ihe_Operatlng Sys_iem_MElJ _
& 5 Compiling, Running, @ (OS/400). It provides programrming information
# E2 1LE coBOL Programmi on how to call other ILE COBOL and non-ILE
@ 0 1€ coBOL Input-Outy COBOL programs, share data with other
# [2 appendixes +|l| programs, use pointers, and handle exceptions.
4« = | ,I It also describes how to perform input/output
- = operations on externally attached devices,
EI i | ,;‘::J | m datahase files disnlaw files _and IGF files ;I

Having the latest version of the manuals at your fingertips will make it easier
to find programming information. There is also the option to search the help
by specifying a search string. By default, the complete help will be searched.

To limit the search to specific documents:
1. Click Search scope.
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The Select Search Scope dialog opens.

| m@arch scogaﬂl topics

2. Click the Search only the following topics radio button.
3. Click New.

=10/ x]

@ iseries program

@ Support informe
Q Tool developer i
@ J2EE SDK 1.3.1 A
@ Remote System
@ 125ESDK 1.3.1 2
@ websphere App
Q Application dew
@ Rational ClearC:

@ iseries applicati 7} Select Search Scope - M

Y

© Remote System (" Search all topics
arch only the Following topics:

Coome Dot

Remay:

(1]

04

Cancel |

the left. Click
Forward
nics.

in the entire
ch field. Click |
ow scope of
U are interesteq

2|

After you run a search and find a topic you were looking for,
click the Synchronize button () 1o match the navigation
tree up with the current topic. You might also find it useful tc

synchronize after following in-topic links.

More information

4

| o

Chapter 6. Editing Source

41



N o o s

8.

The New Search List dialog opens:

2 New Search List - Microsoft =l P

{ ii‘ieries programming )
Topics aren:

iSeties application developer information
ties pragramming information

Remoke System Explorer Developer Guide

™ Support information

™ Tool developer information

[” J2EESDK 1.3.1 APIs

™ Remoate System Explorer User Guide

[ J25E5DK 1.3.1 APIs

™ websphere application Server Network
Deployment

r Application developer information

I Rational ClearCase

ok |) cancel

In the List name field, type iSeries programming for example.
Select the iSeries programming information check box.

Click OK.

Click OK in the Select Search Scope dialog.

Now, if you wanted to do another search, you would only search in the iSeries
programming information topics.

Minimize the Help window.

Prompting RPG language specifications

42

Instead of entering or changing code directly in the Editor window, you can use
prompts. When you request a prompt for a specification line, a window appears
where you can enter or change that line using entry fields.

To access prompts:

1.

Return to the workbench. In the Editor window move your cursor to the
D-spec on line 33.

Click Source from the workbench menu.
Click Prompt (or press F4).

The Editor window will reduce in size and allow you to see the iSeries Source
Prompter at the bottom of the workbench. The iSeries Source Prompter shows
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the specification line broken down into its individual fields.

elcome | ZmsTDSP | FPRROLL X B2 Qutline 6 x
Row 33 Column 10 Replace E-f@ Global Definitions
..... DNanE+++++++++++ETDSFrDm+++TD/L1 i &EE] Files
00zz00 F* used are - MSTDSP - maintal| B-C3 Indicators
002300 F - EMPNST - enplc_g| @ ®-f= Fields
002400 F* - PRJMST - proje =L Main Procedure
002500 F* - RSNNST - reasc ®-C& subroutines
002600 ) e el ol i el i e ol ol ol e o
002700 FMSTDSP CF  E
002800 FEMPMST UF & E K
002500 FPRIMST UF 4 E K
003000 FRSNNST UF & E K
003100 D*
003z00 D* Compile time array contait
003300 D ERR S -
4 | o
@ iSeries Source Pro BP P % x
Line bype: |D: Definition |
-
Externally Data structure Definition Interna™ |
MName described bype type  From TojLength daka byp—

| ERR | = | = Is A | so | -
« « « « « DName+++++++++++ETDsFrom+++To/ L+++IDc . Keywords+++++++++++++ »
«| | »

Remiote System Details |Tasl-<s |iSeties Table View iSeries Commands Log |iSer1&s Source Prompter |

On the iSeries Source Prompter toolbar you can use the three push buttons to:

Disable source prompt view, Disable syntax checking, and Change to insert
mode.

To display context sensitive help for any field in the iSeries Source Prompter:
1. Tab to the Keywords field.
2. Press F1 to see help for this field.

The Help window with help for the D spec keywords opens. If it doesn’t

appear automatically, you might have to bring it to the foreground by clicking

on its icon on the Windows task bar.

You will see words in the help that appear in a different color than the regular
text. These are help links, and they show that there is additional help available

on that word or phrase.
3. Click on any link to see specific help for that item.
4. Minimize the Help window.

To get to the iSeries Source Prompter from the maximized Editor window
without bringing the size of the Editor window down, position the iSeries
Source Prompter on the left task bar as a Fast view.

To create a fast view:
1. Right-click the iSeries Source Prompter title bar.
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2. Click Fast view on the pop-up menu.

Restare

Line by

»

Externally Data structure Definition Interna™ |
described type type  From TofLength data byp—

| = | = Is =l | so | -
« « « « « DHame+++++++++++ETDsFrom+++To/ L+++IDc. Eeywords+++++++++++++ »
«| | 3

Remate System Details | Tasks iSeries Table Yiew |iSeries Commands Log | iSeties Source Prompter |

You will see the iSeries Source Prompter icon on the task bar on the left hand
side of the workbench

3. Double-click the PAYROLL tab to maximize the Editor window.
4. Select a line in the Editor window and press F4 to prompt for a line.

The iSeries Source Prompter will be placed on top of the Editor window.

1< ,@ P _ x #MSTDSF [ FPaTROLL x|
% 'J"EI Column 3 Replace
B - pWarte +++++++++++ETDSFEOW+++To/ L
EE' 0 F* used are - HSTDSF - wainta|
J F* - EMPMST - emplc_g
Exterr F* - PI:‘JM'.EE - proje
Mame deseril F* - R3NM3T - reasc
Ftﬁ.‘.—*.‘.—tﬁ.‘;*.‘;tﬂ'.‘;*.‘;*ﬁ'#*.‘;*ﬁ'#*.‘;*ﬁ'#i
I ERR I i FHSTDSP CF E
DName +++++++++++E FEMPHST vr oA E R
“““ e FPRINST UF & E i
FRSNMST UF L E K
D?}
D* Cowmpile time array contair
D ERR S v
[ »
immands Log
-
_|_|‘ Ll \m Details | Tasks | iSeries Table View |iSeries Commands Log]

5. Click the iSeries Source Prompter icon on the task bar to minimize the iSeries
Source Prompter.

6. Double-click the PAYROLL tab to return the Editor window to its original size.

Indenting RPG source

When editing ILE RPG source, it can be difficult to determine the beginning and
ending of constructs. The indent option allows you to view your source with
constructs in an indented mode. By default, the indent option will split the screen
horizontally and show the indented view in the bottom pane.
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To indent source:
1. Click Source > Show Indentation from the workbench menu.

The iSeries Indent view opens at the bottom of the workbench.

1 Welcome |/MSTDSP ] /PA‘(ROLL xl :E Qutline S§3 x
Row 33 Column 3 Replace B-% Global Definitions
... . DNawe+++++++++++ETDSFromt++To/ L4 | B-Y Files
p0z2z200 F* used are - MN3TDSP - ma:i_nt_:l (3 Indicators

002300 F - EMPHST - emplc_g = [f= Fields
002400 Fe - PRIMST - proje | =0 Main Frocedure
aozso0 F* - RENM3T - reasc Ca Subroutines
00z 600 Froa s st a A S s A A ARSI RFAS RN AAEEERS

ooz7oo0 FHSTDSP CF E

o0zso00 FEMPHNST UF & E K

oozoao FPRJMST UF L E K

03000 FRSHMST UF 4L E K

003100 D*

003z00 D* Compile time array contair

oozzoo | o ERm ] -

4| | »

x
Browse
4 + 5 + 6 +
D ERR S 50 DIM(10) CTDATA PERRCD(:_I
D EMESS s 50 =
E‘a‘
ct#*tx*ﬁHEH%H?%‘H%‘*??H%‘*?ﬂ‘#%‘***??H?*?EH%‘*?EH?*?EH%H*RE*H =
4| | 3
Remote System Details ]Tasks |i5eries Table View |iSeries Commands Log [iSeﬂes Indent I
You can display the iSeries Indent view as a full view.
2. Double-click the iSeries Indent view title bar.
ﬁ K iSeries Indenk x
|% 1 change. Browse
Fo ¥ + + 3 + 4 + 5 + E—-
df c* Al
C* Determine update mode and perform record add or upc
Cw
| ¢ | IF not *inkc
[
C | | Zelect
C | | WHEN ACODE = 'A' and *Ir
[ | | | MOVE 'y AC
c | | | WRITE RBCRSN
CH
[od | | WHEN ACODE = 'A' and not
[ | | | MOVE 'y A
[ | | | UPDALTE RCRSN
C'K
[ | | When ACODE = 'D'
[od | | | MNOVE ‘D! A
C | | | UPDATE RCRSH <
4] | » |

3. Scroll down to line 150.

In this area you see some nested conditions with indented lines. As you will
notice this helps to recognize the beginning and ending of these conditions.

You can move this view as a Fast view to the left task bar as well.
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Note: The Indented view is Browse mode only and cannot be edited.
4. Click the X in the top right corner of the view to close the iSeries Indent view.
5. This returns you to the Editor window with the PAYROLL program.

Finding and replacing text

46

The LPEX Editor also has a powerful find and replace text feature. You use the
Find and Replace window to search for an item. You can search for a word, a
partial word, or a sequence of such. You can also enter a pattern you want to
match, provided that the pattern follows the rules of regular expression. You can
replace the found search item. If the entered text or pattern is found, the cursor
moves to either the next or previous occurrence of the search item, according to
your chosen search direction, and replaces the found text according to your
selections.

To find and replace text:
1. Press Ctrl+Home to go to the top of the PAYROLL file or the PAYROLLC file.

Tip: When you press Ctrl+Home to get to the top or Ctrl+End to get to the
bottom, a quick mark is set at your cursor position. This allows you to get
back to that line by pressing Alt+Q. Ctrl+Q will set a quick mark.

2. Double-click the PAYROLL tab or PAYROLLC tab to maximize the Editor
window.

3. Click Edit > Find/Replace from the workbench menu or press Ctrl+F.
The Find/Replace window opens at the bottom of the Editor window.

Awsose [ X |

Row 57 Column 36 Replace

..... CLONO1Factorl+++++++0pcode (E) -I-Extendtd—fastor2+++++++
005700 c EVAL PRIAPL = *BLANK 2]
Qaosso0 C EVAL RSMAPL = *BLANK
aossoon c=
a0e000 C* TWrite the SELECT format to display. If end of —
008100 c*
006200 c*
006300 Cc nom not *INeD
a06400 C ]: EEFMT SELECT
006500 C *INEC IFEQ ‘1!
006600 [ LEAVESE
008700 o ELSE
00s300 [ EXSR EDITSL
a0s6500 C END
aovooo c*
007100 C* IF the general error indicator ¥INEO is on [(equ
007200 C* program continues to loop
007300 c*
aov400 C ENDdo -
4| | ’|
) e | reveus |
Renlac@ Replace Replace all
I~ Casesensitive | Regular expression W ‘Wrap [ Select found text |~ Restrict search to select
I Restrict search ko columns Start column ll_ End column W |

At the bottom of this window, you will notice that you have some options to
select from, for example, search only in certain columns, etc. You want to find
the first occurrence of PRJAPL and replace it by the word PROJAPL.

4. In the Find field, type PRJAPL.
5. Press the tab key to move to the Replace field and type PROJAPL.
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The Editor moves the active line to line 57 in the RPG source or 194 in the
COBOL source, which contains the first PRJAPL in the file.

Click Replace to replace PRJAPL with PROJAPL.
Click Next to go to the next location of PRJAPL in the file.
Click Replace all to replace all occurrences of PRJAPL with PROJAPL.

Double-click member PAYROLL tab or PAYROLLC tab in the Editor window
to return the PAYROLL or PAYROLLC Editor window to its original size.

10. Close the PAYROLL or PAYROLLC window.
A window will appear asking you to save the latest changes.
11. Click No.

12. From the iSeries Projects Navigator, double-click PAYROLL to reload the RPG
original source or PAYROLLC to reload the COBOL original source.

© ©® N o

Filtering lines by string

The editor allows you to filter or subset your source so that you see only lines
containing a given string. Filtering lines makes it quick and easy to find lines
without having to scroll through your source.

| o11o00 c RSNTAG BEGSR
0oooz9 * oare: P - maintenance diaplay file
000o30 * PHST - employee master file

To filter source by string:

1. Double-click the BEGSR in PAYROLL or MSTDSP in PAYROLLC in the Edit
window to select it.

2. Select Edit > Selected > Filter Selection from the workbench menu.

Owekome | Zmsose (DL X |
Row 347 Column 1 Replace
I. «+ « CLONO1Factor 1+++++++0Opcode (E) +Factori +++++++Result+d
005200 C MAIN EEGSE
011000 C RENTAG EEGSR
018300 C ENPTAG EEGER
0z 6400 C FRJITAG begsr
034700 C EDITSL EEGER
040400 C LCDESE EEGSE
043100 C ADDCDE EEGSER
044400 c CHGCDE EEGER
046100 BEGSR DELCDE:
047600 BEGER INWCDE};
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Awstose AL X |
Row Z9 Columm 14 Replace
————+—*A—1—B—I+————2————+————3————+————4————+————5————+—
I
H ooo0z9 * are: MSTDSP - mwaintenance display file
000037 SELECT M3TDSP-FILE
B 000038 LAS3IGH TO WORKSTATICN-MSTDIFP-3
000068 FD MSTDSP-FILE.
000069 01 M3TDSP-REC.
(u]u]uluirin] COPY DDS<ALL-FORMATS OF M3TDSP.
ooo132 o1 HSTDS&rIND—USkGE.
000154 OPEN I-0O MSTD3FP-FILE
000160 INITIALIZE MSTD3P-REC.
000167 CLOSE MSTDSFP-FILE
000179 WRITE MSTDSP-REC FORMAT IS 'SELECT!'
000183 READ MSTDSP-FILE FORMAT IS 'SELECT!'
ooozzo INITIALIZE MSTDSP-REC
ono0z94 WRITE M3STDSP-REC FORMAT IS 'EMPSEL'
oo0z98 REALD MSTDSP-FILE FORMAT IS 'EMPSEL'
000343 WRITE MSTDSP-REC FORMAT IS 'EMPMNT'
000347 READ MSTDSP-FILE FORMAT IS 'EMPMNT'
000394 WRITE M3TDSP-REC FORMAT IS 'PRJSEL'
000398 READ MSTDSP-FILE FORMAT IS 'PRJSEL' —
000443 WRITE MSTDSP-REC FORMAT IS5 'PRJIMNT'
000447 READ MSTDSP-FILE FORMAT IS 'PRJMNT'
000494 WRITE MSTDZIP-REC FORMAT IS 'RSNSEL' hd
«| y|

3. Move the cursor down a few lines to line 347.
4. Click the plus sign beside line 347 to expand this section.

welome | ZMSTDSP x |

Row 347 Column 1 Replace

I....CLGNG1Factor1+++++++0pcode(E]+Fact0r2+++++++Result+1
=

005200 C BEGER

011000 C EEGER

018300 C EEGESR

0z 6400 C begsr

034700 C BEGSR

034300 cF

034900 C* Housekeeping, clear display fields and reset i

035000 c*

035100 C MCVE *BLANES EMESS

035200 C EVAL *INE0D = *OFF

035300 c*

035400 C* The following IF AND OR combination checks the

035500 C* selection fields to ensure that only one appli

035600 C* szelected.

035700 cF

035800 C EMPAPL IFEQ 4

035900 C ANDEQ '

036000 C OREQ (4

036100 C R3T ANDEQ e

036200 cF THE BUG IS5 HERE ‘:J

|
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_#MSTDSP / Paxi X |
Row 347 Colwwn 1 Replace
- —— - 2 - 3 - 4 - 5 -

000160 INITIALIZE MSTDSP-REC. |
000167 CLOSE  MSTDSP-FILE
000179 URITE M3TDSP-REC FORMAT IS 'SELECT'
000183 READ MN3TDSP-FILE FORMAT IS 'SELECT'
000220 INITIALIZE MSTDSP-REC
000234 WRITE MSTDSP-REC FORMAT IS 'EMPSEL'
000298 READ MSTDSP-FILE FORMAT IS 'EMPSEL'
000343 URITE MSTDSP-REC FORMAT IS 'EMPMNT!
bUDSQ? READ MSTDSP-FILE FORMAT IS 'EMPHMNT'
000348 INDICATORS ARE IND-TABLE
000349 1 END-RELD. —
000350
000351 INITIALIZE RCEMP.
oo0352 MNOVE COER EMPMNT-I TO RCEHNP.
000353 MOVE WS-EMPHNO TS EMPMO OF RCEMP.
000354 MOVE WS-ACREC TO ACREC OF RCEMP.
000355
000356 IF IMD-OFF { IND-MAINT} AND IND-OFF (IND-EQJ)
000357 AND IND-OFF ( IND-EMPS
000358 EVALUATE W35-ACODE
000359 WHEN ' &'
000360 MOVE 'A' TO ACREC OF RCEMP
quu351 IF WS-ACREC = 'D! -

4 | »

Now you want to show the entire source again.
Click Edit > Show all from the workbench menu or press Ctrl+W.

Your cursor is still positioned on the same line that you moved the cursor to,

even though all lines are now showing.
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Filtering lines by type

To help you navigate quickly through your ILE RPG or ILE COBOL source the
Editor allows you to filter lines based on the line type. Imagine you want to see
where all the subroutines are defined in your RPG source or where all the
divisions are defined in your COBOL source.

File Edt Sowce Comple Mavigate Search Project Run  Window Help
IS-HRa|8s-%-%- ||| AIAB|c- -
IR | Ol I |A ¥ &

[ x || Jweome [ 7msrose B x| x
% E Row 52 Column 1 Replace E
— |5 «e.CLOMO1Factor 14+++++++0pcode (E) +Factor 2 +++1 E
= & ooszooll  pew y BEGSR |
! 010200 — e - - endsr :
= 011000 Conktext BEGSR i
017600 Prompt ENDsr E|
= 018300 Syntax Check Line BEGSR
o 025700 Select Format Line... ENDSE
026400 begsr
& 033500 Cut endsr |
=] 034700 Capy BEGSR
L_b_ 039500 Paste ENDSE
= 040400 " BEGSE
X 042700 select Ine ENDSR
[E Select character LI
Select rectangle
g li Selected 3
| =———— Deselect J‘l
& | iseres ndent TR o Date x
Row 1 Shiow all Code Browse
AR Comments s t
& — e Control
- .
e N SN P
Subroutines

4/ MSTDSP m _________ X |

Row 150 Column 1 Replace

p=Fh=1=F b z b 3 b 4 t 5 t

000145 01 WS-ACODE PIC A. -]
000146 01 W3-ACREC PIC X.

000147 01 WS-EMESS FIC X(50).

000148 Syntax Check Line

000149 e

DOD150 PROCEL - d
000151 Copy

0oo152 oooo-p  Paste

= e |

000155 zec: d“'a':tz TLE

000156 CEEREEETE, , [LE

000157 Selected TLE.

000158

000159 By Date

000160 A

000161

gggi:g * Displ Save m()utine F of job r
000164 PERFORM 0D100-pRO¢ LmpeddedSQUCICS 4y o r
000165 UNTIL IND-OM{Ir_ Cfrs

000166

000167 CLOZE HN3TDSP-FILE -
< ’|
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To filter lines by type:

1. Right-click in the Editor window with the PAYROLL program or PAYROLLC
program.

2. Click Filter view > Subroutines on the pop-up menu for PAYROLL or click
Filter view > Divisions on the pop-up menu for PAYROLLC.

For PAYROLL all subroutines specifications are displayed allowing you to
move quickly and easily to the area in your file where the desired subroutine
is.

For PAYROLLC all divisions are displayed allowing you to move quickly and
easily to the area in your file where the desired division is.

\Wekome | /' msTDSP W X ‘

Row 176 Column 39 Replace
..... CLONO1Factor 1+++++++0Opcode (E) +Fal::|:n:2+++++1

oosz00 C MAIN BEGSER
010200 C endsr
011000 C RINTAG EEGSR
017600 C END=sr
018300 C EMPTAG EEGSR
0z5700 C ENDSE
02z 6400 C PRITAG begsr
033500 C endsr
034700 C EDITSL EEGSE
039800 C ENDSR
040400 C LCDESR BEGSER
042700 C ENDSR
043100 C LDDCDE BEEGSR
044000 C ENDSE
044400 C CHGCDE EEGSR
045400 C ENDSER
046100 BEGSR DELCDE:

047200 EMDSR;

047600 BEGSR INVCDE:

047900 ENDSR:

pvoe T x|
Eow 150 Column 1 Replace
H———+—*P.—l—B——-i—————Z————+————3————+————‘l————+————5————+—
000003 IDENTIFICATION DIVISICH.
0o0o0s PROGRAN-ID. PAYROLL.
000018 ENVIRCNMENT DIVISICH.
000064 DATA DIVISICN.
IJDDISD PROCEDURE DIVISICH.

3. Move your cursor to the line with the subroutine declaration CHGCDE (line
444) in PAYROLL or the procedure division (line 150) in PAYROLLC.

4. Expand the declaration to show all lines in this subroutine or division.
Now you could work with the source inside this subroutine or division.
5. Right-click in the Editor window and click Show All on the pop-up menu.

Searching multiple files

If you would like to search through the members in a source physical file or
through the files in a local directory, you can use the Search tool. The Multi-File
Search utility allows you to search for a particular string of text in many members
on the host. This function can also be used on local files.

To search multiple files:
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1. Click Search > iSeries from the workbench menu.

The Search window opens.

2. In the Search string field, type ENHRS.

B iseries Search I =Y File Search | 22 Help Search I [L¥ Java Search I 2 Plug-in Search |
Search string: i ENHRS ) j I Case sensitive
Connection: |s400a J New.. |

Tergi— .

_|J Browse. . |
JJ Brnwse...l
;u Browse...l

¥ source members I” Data members

~ Columns

& all columns

" Between |'. andla:

" Between(G) I 1 and end of line

Customize... | [ search )| concel

[——

The Connection field should contain your iSeries server name, otherwise enter
it there.

Under Target in the Library field, type RSELABXX.

Under Target in the File field, type QDDSSRC to search all members in this
source physical file.

Under Target in the Member field, select *ALL.
Click Search.

The Multi-File Search window lists all the lines in all the files that reference
ENHRS.

¥ Remote Search ("ENHRS" - 3 Ocel
= II; RSELABXHIQDDSSRC(EMPMST) (1 makch)

A ENHRS R {line 18)
El @ RSELABXXIQDDSSRC(MSTDSP) (1 match)
e Ry EMHRS R B 11 37REFFLD{RCEMP/ENHRS *LIBLJEMPMST) (line 99)

= [@ RSELABXX/QDDSS chy
- ENHRS 31 TEXT(EMPLOYEE NORMAL WEEK HOURS') (ing 223>

Double-click the last line in the list.
A ENHRS 3 1 TEXT('EMPLOYEE NORMAL WEEK HOURS')

The member REFMST is automatically loaded into the editor and the cursor is
placed on the correct line.

Close REFMST.

ILE RPG or ILE COBOL project-based application development



Checking syntax

One of the powerful features that the LPEX Editor shares with SEU is its ability to

syntax check your source. Syntax checking can be done either when the cursor
leaves each line of source or all at once on either the currently selected source or

on the entire file.

Now you will create a syntax error and watch for the prompt to correct it.

To syntax check the RPG file:

1. In the PAYROLL Editor window move the cursor to line 211 which contains

4.

EXSR ACDESR.

You might already be on that line but if not, type the line number in the

sequence number column, or scroll down.
Append an X to the EXSR op-code to make it EXSRX.
Move the cursor off of the line.

An error message appears to draw attention to the error.

Owekome X | Zwsose | Zrerwst 2 x|

4]

Row 211 Column 13 Replace 1 change.
s T . e D T I
DzZ0300 C IF *INKD
0Dz0400 Cc leavesr
0z0sS00 C END
DzZ0s00 c*
0z0700 C* jpoess ewmployee master to validate action code reg
020800 c*
nzosoo Cc IF NOT *INKC
0z1000 C EMPNO HLTH EMPHET
021100 c Cexsrz)  ACDESR
ENF5014E COperation code i3 not valid; specification is igno
Dz1z00 C ELGE
021300 Cc LEAVESR

Move the cursor onto the pink error message.
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5. Press F1.

db Help - webSphere Development Studio Client Advanced Editi - iS -10] x|
Search: | |m Search scope: Al bopics
Contents o) o B S

@ iseries application de R PG M ess ag es

@ iseries programming

@ Remote System Explc
@ Support information

Q Tool developer inform M
@ J2EE SDK 1.3.1 APIs

Operation code is not valid; specification is ignored.
Qs Remote System Explc

@ 1266 50K 1.3.1 APIs || 30

© websphere applicatic|| Cause ... .. : The Operation code is not valid. Mo further
€ application developer|| checking is done on the specification. The operation must
@ pational ClearCase start with a valid Operation Code and can be followed by

an optional Operation Extender. If specified the Operation
Extender must be one or more of A, D, E, H, M, N, F, R,
T, or Z, and enclosed within parentheses.

Recovery . . . : Specify a valid operation, or omit the
specification. Compile again.

[ Top of Page | Previous Page | Next Page | Table of
Contents ]

Copyright IBM Corporation 1992, 2003, All Rights Reserved.

2 | ]

|_«?|ﬁim

This opens a window with second level help for the error.
6. Minimize the Help window.
7. Change "EXSRX’ to "EXSR’ to correct the error.
8. Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.

To syntax check the COBOL file:

1. Click the PAYROLLC Editor window, click Source and then click Source >
Syntax Check All on the workbench menu.

Error messages appear to draw attention to the errors.

1]
AWsTDSE | ZREFMST | / paiE x|

Fow 91 Coluwn 35 Eeplace

s i e e .
000085 | A
000086 01 ERROR-MESSAGES.
000087 05 MSG-TABLE. i

000088 10 MSG-1 pzc VALUE
LNCZS530E Unmatched right parenthesis. Hight parenthesis

LNC1248E PICTURE string 'X50)' does not describe wvalid d

000089 ' MAINTENANCE SELECTICN CODE NOT EQUAL
oooo09o0 10 M3G-2 PIC X(50) WALUE
ain]nini=h} 'MORE THAN ONE APPLICATION SELECTED FOR
oooosz 10 MSG-3 PIC X (50} VALUE
000033 ' NC APPLICATION SELECTED FOR MAINTE
000094 10 M3G-4 PIC X(50) WVALUE
000095 ! LCTICN CODE MNOT EQUAL TO faAr™, M™Cr O
00o09e 10 MSG-5 PIC X (S0} WVALUE

4 | L'LI
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2. Move the cursor onto a pink error message.

3. Press F1.
4P Help - WebSphere Development Studio Client Advanced Edition =]
Szarch: | |m Search scope: All topics
Contents &2 G Bl 5

o

7.

Q iSeries application dey,
© iseries programming i
@ Remote System Exploi
@ Websphere Applicatiol
@ 325E SDK 1.3.1 APIs

Q Application developer
Qs Tool developer inform
€ 12EE SDK 1.3.1 APIs

€ Remote System Exploi
Q Support information

4« | »

|?'~‘?[sé9'|m

COBOL Messages

LNC2530
h@matched right parenthesis. Right parenthesis ignored.
30

Cause .. ... : Thereis a right parenthesis in the picture
string without a matching left parenthesis.

Recovery . . . : Remove extra right parenthesis or supply its
matching left parenthesis.

[ Top of Page | Previous Page | Next Page | Tahle of
Contents |

Copyright IBM Corporation 1992, 2003, All Rights Reserved,

This opens a window with second level help for the error.

Minimize the Help window.

Add the required left parenthesis to correct the error.

Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.

Close the file and save the changes.

Tip: You can toggle automatic syntax checking. Click Window > Preferences from

the workbench menu and then expand Remote Systems, iSeries, LPEX Editor

Parsers, ILE RPG or COBOL in the left pane of the Preferences window, select the
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Automatic syntax checking check box, then click OK.

&P preferences

= 2| 1ErPG

=  Remote Systems
. Communications ¥ Automatic syntax checking
- _Fies I Automatic uppercasing
Cache Enter key behavior

- Command Executio ¥ Repeat previous specification type
E:’“ma"d Sbmtf I Repeat previous operation code (if on C-Specification)
: [ Set C-Speification cursor position
Position Im
i I Set free form C-Specification cursor position
Pasition |3—

[~ Set D-Speification cursor position

Cbjects
fﬂ Program Yerifiers Position I FROM - I
Templates
- Logging I™ User defined tabs
- Passwords e =
& Server |H. Control J
- Spell Check [ HEeywords+++ttt bttt ttttdt bttt
- Symptom Database = —
[#- Team I
¥ UML Yisualization e~ |3—

4P Preferences

User Profile :l COBOL
[+ C:\Documents and Sett
[ C:\Documents and Sett
[+ C:\Documents and Sett - I::?er defined tabs
[#- Plug-In Development
[+ Profiling and Logging
% RAD | T - -
@Remnte Systems I
Communications

. - Files and every: [I:l
: @ iSeties
0 beCache

- Command Executio

~-Command Subsyste
; - Job Subsystems
I @ LPEX Editor Parsers

-€CoBAl

[Indicates that the parser should use the tabs defined here rather than the parser defaults. |

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. When column sensitive editing is selected:
a. Each column is considered a separate entry space

b. If you are inserting or deleting characters into a string that is in the Factor
2 entry, the result field entry does not move

C. The default editor preference is that column sensitive editing is off
d. All of the above

2. The LPEX Editor has predefined settings, but also has an associated preference
page containing settings that you can define. (T, F)

3. LPEX Editor preferences are set in the:
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10.

11.

Preferences window
Editor window

New wizard

a0 o

Remote Systems view

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. (T, F)

If you want to undo a set of changes made to a file you must use the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

You can also cancel the effects of an undo operation by using the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

This help is invaluable if you cannot remember the order of fields in an RPG
specification or the possible values for a variable field. Name the help. Choose
the best answer.

a. Context sensitive help
b. Language sensitive help
c. Display help

d. Field help

To receive language sensitive help, press ____ key in an Edit window. Name
the key:

a. F2

b. F3

c. F1

d. F4

If the cursor is a field, you receive help for that field.
a. Before

b. After

c. On

d. Off

Instead of entering or changing code directly in the Editor window, you can
use

a. Prompts

b. Filters

c. SEU commands
d. Format line

e. All of the above

views are hidden views, which can be quickly made visible. They work
identical to normal views, the only difference being that when hidden they do
not take up screen space on your workbench window.

a. Remote Systems

Chapter 6. Editing Source 57



12.

13.
14.

15.

16.

17.

18.

19.

b. Navigator

c. Outline

d. Fast

The option allows you to view your source with constructs in an
indented mode. By default, the option will split the screen

horizontally and how show the indented view in the bottom pane.

a. Fast view

b. Outdent

c. Indent

d. Edit

The indented view is browse mode only and cannot be edited. (T, F)

You use the window to search for an item. Choose the best answer.
a. Search

b. Find

c. Edit

d. Find and Replace
You can search for:

a. Aword

b. A partial word

C. A sequence of words

d. A pattern if it follows the rules of regular expression

e. All of the above

The LPEX Editor allows you to ____ or subset your source so that you see
only lines containing a given string.

a. Search

b. Find

c. Sort

d. Filter

To help you navigate quickly through your ILE RPG source the editor allows
you to filter lines based on the . Choose the best answer.

a. String

b. Line type

c. Line number
d. All of the above

If you would like to search through the members in a source physical file or
through the files in a local directory, you can use the tool. Choose the
best answer.

a. Compare

b. Search
c. Find
d. Edit

Syntax checking can be done either when the cursor leaves each line of source
or all at once on either the currently selected source or on the entire file. (T, F)

More practice

58

Want more practice? Try this!
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Given your experience in this exercise using the Remote Systems LPEX Editor, try
these new tasks: Check out how token highlighting works in your ILE RPG source.

Display a format line and use it to enter your source. Filter source by comments.
Set auto-uppercase on. Use the Development Studio Client for iSeries online help
to assist you in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:
* The benefits of each language editing feature

* How to do column sensitive editing

* How to enter SEU commands

* How to undo and redo editing

* How to access help for language elements

* How to prompt on language elements

* How to indent source

* How to find and replace language elements

* How to filter the source by string and by line type
* How to search files

* How to compare files

* How to syntax check files

Now that you have mastered editing source, you can move on to verifying your

source to ensure you have a clean compile on the iSeries system. This approach
saves you iSeries cycles! Continue to the next module.
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Chapter 7. Verifying source

In this module, you will learn how to verify source in the Remote Systems LPEX
Editor. The program verifying and program compiling are the final steps in
compiling a program or module. When errors are found by either, the iSeries Error
List appears. The iSeries Error List is a powerful tool that manages errors found by
verify and compile utilities in the Remote Systems LPEX Editor. You will become
familiar with these tools, the various capabilities of the iSeries Error List and the
program that you have created.

In order to verify source, there are several steps you will need to learn about and
follow:

* Describe the purpose of the Program Verifier
* Invoke the Program Verifier
* Insert messages and checking that errors were fixed using the iSeries Error list

¢ Submit iSeries commands using the iSeries Table view

In order to accomplish these learning objectives, there are several steps that are
involved, including:

¢ Invoking the Program Verifier
* Reviewing the iSeries Error List

* Fixing Errors
The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Verifying RPG or COBOL source

Now you get to play with one of the most powerful and unique features of the
Development Studio Client — the Program Verifier.

Before you compile your code on an iSeries, you can make certain that there are no
errors by invoking the Program Verifier. The verifier checks for semantic (compile)
errors on your workstation so that you can guarantee a clean compile on the
iSeries. Think of the host cycles you’ll save. It is especially handy when you are
writing code but you are disconnected from an iSeries. You can do this because
Development Studio Client ported the parsing and checking code from the iSeries
system compilers to the workstation. The iSeries Error List window lists the errors
that are found and their severity, inserts the error messages directly into the source
and helps you to navigate between the errors.

Note: Make sure that your user ID has been setup, so that your library has been
added to the library list automatically. You can use the properties for iSeries
Objects dialog to set connection information such as adding a library to a
library list and changing the current library. From the Remote Systems view,
you can right-click on iSeries Objects then click Properties to see this dialog.
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You will need this setup to run jobs interactively from your workstation.

4P Properties for iSeries Dbjects

Command Execution
Environment Yariables

Subsystem

Initial Library List
—Library list
Library: |
Librar Library Position
RSELABX (CFIRST )

Move Lip

=10l x|
Remove
[t

Move Diowrny

Current library: | "USRPRF |
Initial command:
c ICHGCURLIB RSELABKK D
Restore Defaults | Apply I

.

To invoke the verifier:

1. Click the PAYROLL tab to verify RPG source or PAYROLLC2 tab (you will
need to open the PAYROLLC?2 file for edit first) to verify COBOL source.

2. Click Source > Verify from the workbench menu.

After a moment the verifier will display an iSeries Error List below the Editor
window.

Message

| 5. L..] Location

URNF...  ENDSR operation is missin...

D

@ RNF... Thename or indicator EME, ..
@ RNF... Thename or indicator RSN, ..
@ RNF... Theoperand RSNTAX of E...
o
a9
i

RNF... Factor Zmustbe'D'or'1' ..,

RMNF... Move operands ERR andE. ..
RMF... RPG provides Separate-In...

3.1 RSELABKXJQRPGL..
.. RSELABX®/QRPGL.., s400a
.. RSELAEX:/QRPGL... s400a
.. RSELABX®/QRPGL.., s400a
.. RSELAEX®/QRPGL.., s400a
.. RSELABX:/OQRPGL... s400a
.. RSELAEX®/QRPGL.., 54003

o W oW W oW W
ML o oL
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:LNC1904 Pr:ograrn PAYROLL syntax checked, Errors ...

1 RSELAEXK/QCELL, .. 54002
302 RSELABAXMQCELL... s400a
402 RSELABXX/QCBLL... s400a
606  RSELABXXMQCBLL.,.. s400a
184  RSELAEXX/QCBLL... s400a
299 RSELABAXMQCELL... s400a
348 RSELABXX/QCBLL... s400a
399  RSELABXXMQCBLL... s400a
443  RSELAEWXMQCBLL... s400a
499  RSELABXX/QCBLL,.. 5400a
548 RSELABAX/QCELL... s400a

LNC1463 'EMPHNOC" is not unique in this contesxt, Use ..,
LMC1326 'PRCD OF PRJSEL-I' not defined name. Sta...
LNC1329 Subscript value '14' exceeds maximum occ..,
LMNCO407 AT EMD phrase missing from sequential RE...
LNC0407 AT END phrase missing from sequertial RE. ..
LNCO407 AT EMD phrase missing from sequential RE. ..
LNC0407 AT END phrase missing from sequential RE. ..
LMCO407 AT EMD phrase missing from sequential RE...
LNC0407 AT END phrase missing from sequential RE. .,
LNC0407 AT END phrase missing from sequertial RE. ..

U QRO 0 R0 JO< <]
BEEEEEBEE8E88)Y

The error list shows you:

The error message itself
The severity

The line number

The source location

The connection name

Fixing RPG errors

Next you fix the errors in your source.

To fix an error in your source go the error list:

1.

Double-click the error RNF7030.

You are automatically brought back into the Editor window to the line where
the error occurred. The error on line 365 is a typo. The variable EMES is really

EMESS. One good way of finding the correct name is the content assist.

] Welcome - x l
Row 365 Column 50 Replace
..... CLONO1iFactor 1+++++++0pcode (E) +Factors ++++++ sult++++
036500 G MOVE ERE (2) E|
RNF7515: Mc{EMESS [ Eemess
RHF7030: Th ]
f char{50) IEMPHO
036600 [ T IEMPAPL
036700 [ FIEMCAT
036800 i
oass00  cr il
037000 C* Th i
037100 cT  ap ENAME
037200 c* Prenrrs
037300 C IFEQ vt
037400 i AMDEQ vt
037500 C ANDEQ ro
037600 [o MOVE r1e *IHAEO
037700 [o MOVE ERR (3] g
1 |
Verify program action completed with errors.

Refresh the Outline view.
Select the misspelled variable and press CRTL+spacebar.

If the variable starts correctly the selection presented contains the correct
name.

Double-click the variable EMESS in the list to correct the variable name.
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Another way is find the variable name is to use the Outline view and see
what variables are declared.

8= outline 69 x
-}i— Fields -

{21 ACODE : Character (1)
: L:D ACREC ; Character (1)
-([1 EDEPT : Character (S)
-0 ELOCN & Character (30)

K s haatr G013

RIE o o e
(1 EMPNG : Packed Decimal (6,0)
- ENAME : Character (30)
-0 ENHRS : Packed Decimal (3,1) —
{21 EPHRC ; Packed Decimal (5,1)
-1 EPHRP : Packed Decimal (7,1}
-] EPHRY : Packed Decimal (7,1}
) EPNRC : Packed Decimal (5,1)
- EPNRP : Packed Decimal (7,1}
{1 EPNRY : Packed Decimal (7,1)
- ERR : Character (S0) DIM{10)
-] EUSRI : Character (8)
LT PRONE « Fharacker (2 | R Iﬂ

4

The next error is a RNF7030 as well.
Double-click RNF7030. Fix it in the editor.
RSNTAX should really be RSNTAG.

Make the appropriate change.

Go to the next error RNF5184.

The next error is actually RNF7018 but it is related to the first one and can be
ignored. It shows the same line number, which an indication that both errors
are related.

Double-click RNF5184.

Certainly somebody didn’t know their RPG and tried to assign a value 2 to an
indicator.

Fix this by replacing the 2 with a 1.

Error RNF7515 is related to the first error you fixed. It has the same line

number. You can ignore it. The only serious remaining error is RFN5178. This
error is caused by a missing ENDSR.

Note: The verifier could not determine where the ENDSR is missing so the
line number reported is 1, for this reason you can’t just double click on
the error message. You need to investigate where the missing statement
belongs.
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10. Move to line 398 in the editor.

* ] Welcome /7 pal x
Row 398 Column 1 Replace
B....... ToveeFeeeaZuoneatenaBeeeateneateeatan . Buusot

038600 c HOVE ERR(1) EMESS 4|
038700 C END

038800 C FRJAPL IFNE v

038900 C PRJAPL ANDNE vE!

033000 C HMOVE 1 T INGC
039100 c HOVE ERR(1) EMESS
039200 C END

039300 C RSMAFPL IFNE v

039400 c RSMNAPL ANDNE B q

039500 C HOVE ' *INsC
039600 C MOVE EER(1) EMESES
039700 END [
bassoo @ ENDSE

039900 L

quaoo (_‘ﬂ"xS'TT'X'-‘."K3".‘73"-‘7'!3".‘7*'-’.13".‘73"-‘7'!3".‘73"-‘7'!3".‘7*'-‘71S‘TT'X?TT*?T*?TT*'KT'.‘TTR'

< | 2
|

11. Remove the asterisk (*) from the C-spec.
You can use the Tab key to quickly move to the appropriate column.

All the non-informational errors are now fixed. You can filter out different
severities by using the filter menu.

X3 iSeries Error List - <TORASOTM

@m P o v i Information
IID IMwsaqg IS..[L.J Locat JVRF

@ RNF... EMDSR operationismissin... 3...1 RSEL v & Error =
'.'ll RMF...  The name ar indicabor FMF... 3.0 3. RSFl.

4 v [ Severe »
Tasks |iSeries Ta... |iSeries Co... |RemoteS... |iSeries Fie v W Terminating (N

12. Click the arrow in the iSeries Error List title bar.
13. Click Show Severity on the pop-up menu.
14. Clear the severities you don’t want to see in the list (Warning for example).

Fixing COBOL errors

Next you fix the errors in your source.

To fix an error in your source go the error list:
1. Double-click the error LNC1463.

You are automatically brought back into the Editor window to the line where
the error occurred. The error is caused by EMPNO not being uniquely defined.
Go to line 302 where EMPNO is defined. The variable EMPNO should be
EMPNO OF EMPSEL-I.

2. Make the change.
The next error is LNC1326.
3. Double-click LNC1326. Fix it in the editor.
4. PRCD should really be PRCDE.
Make the appropriate change on line 402.
5. Double-click LNC1329.
This error is because the array was declared with 4 elements. Go to line 606.
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6.

7.
8.
9.

Change the index of the array from 14 to 4.

The next errors are LNC0407. You can ignore these errors as they are severity
20.

All the severity 30 errors and above are now fixed. You can filter out different
severities by using the filter menu.

" v i Information
IID IMwsaqg IS..[L.J Locat: JERF QR Jing
\

@ RNF... ENDSR operationismissin... 3.1 RSEL v @ Eror
'.'ll RNF...  The name arindicator FMF... 3.0 3., RSFLs
4

v [ Severe
Tasks |iSeries Ta... |iSeries Co... |RemoteS... |iSeries Fie v W Terminating

Click the arrow in the iSeries Error List title bar.
Click Show Severity on the pop-up menu.
Clear the severities you don’t want to see in the list (Warning for example).

Saving the source and verifying source again

Now before you loose any of your changes, it’s a good idea to save them. Make
sure the PAYROLL member is selected. You then verify the source again to make
sure that all the errors are fixed.

You can save the member using one of these ways:

1.

2.
3.
4

Click File > Save from the workbench menu.
Click the Save icon in the workbench toolbar.
Press Ctrl+S.

Verify your source again; Source > Verify.

*3 iSeries Error List - -iTORnSD?Mﬂ; |

D Message | sev... | Line | Location |
i RMF7089 RPG provides Separate-Indicat... 0 27 | RSELABXXJQRPGL...
1 RNF7031  The name or indicator *INO3is ... D 1 RSELABXA/QRPGL...
i RNF7031  The name or indicator *INO4is ... 0 1 RSELABXY/QRPGL. ..
i RNF7031  The name or indicator *INOS is ... 0 1 RSELABXX/QRPGL...
1 RNF7031  The name or indicator *INO&is ... 1) 1 RSELABXA/QRPGL...
i RNF7031  The name or indicator *INO7 is ... 0 1 RSELABNAQRPGL. ..

iSeries Error List - < TORASD! =N .
D Message [ s... | Line | Location | conmection
{ LMCO407 AT END phrase missing from sequential RE,.. 20 184 RSELABXXJQCELL... s400a
LNC 0407 AT END phrase missing from sequential RE,.. 20 299  RSELABSWIQCELL... s400a
LMC 0407 AT END phrase missing from sequentisl RE... 20 348  RSELABxXJQCELL... s400a
LMC 0407 AT END phrase missing from sequential RE,.. 20 399  RSELABYYIQCELL... 54003
LMC 0407 AT END phrase missing from sequential RE,.. 20 448  RSELABXX/QCELL... s400a
LMC0407 AT END phrase missing from sequential RE,.. 20 499  RSELABXXJQCELL... s400a
LMNC 0407 AT END phrase missing from sequential RE,.. 20 548 RSELABRW/QCELL... s400a

o

00000 Q

Remote System Details | Tasks | iSeties Table View |iSeries Commands Log | iSeries Error List |

Everything should be ok. You are ready to compile the program.

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.
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1. The tool checks for semantic (compile) errors on your workstation so
that you can guarantee a clean compile on the iSeries.

a. Compile
b. LPEX Editor
c. Program Generator
d. Program Verifier
2. The view identifies each error with an icon that identifies the

severity level of the error, the ID of the error, the message, the severity, the line
in the source member that caused the error, the location of the source member

that produced the error, and the connection name.
a. Remote Systems
b. Outline
c. Navigator
d. iSeries Error List
3. You can sort the entries in the iSeries Error List view by:
a. ID
b. Message
C. Severity
d. Line
e. Location
f. Connection
g. All of the above

4. If you used the local program verifier, then your host compiles should be
successful; no wasted iSeries cycles. (T, F)

More practice

Want more practice? Try this!

Given your experience in this exercise using the Program Verifier and that you

have your own source on your own iSeries system try these new tasks: Check out
Verify again on your source files. Assuming you receive errors in your source (add
some errors into your source if you don’t have any) when you verify your source,

choose insert all error messages into the editor from the Error list. Use the
Development Studio Client for iSeries online help to assist you in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:
¢ The purpose of the Program Verifier

* The purpose of the iSeries Error List

* How to invoke the Program Verifier

* How to view and fix errors using the iSeries Error list

* How to save the fixed source

Now that you know how to verify source, you can move on to compiling the
source. Continue to the next module.

Chapter 7. Verifying source
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Chapter 8. Building the iSeries Project

So now that the code has been edited locally and verified against any syntax
errors, you are ready to perform a build (or compile) on the source members under
a given iSeries project.

Associated with each iSeries project is a Build Style which basically determines
how source members under that project will be pushed and compiled on the host.
A build style is a set of actions that provide push and build operations for a given
iSeries Project.

In this module, you will learn how to select a build style, compile a single file or
compile an entire iSeries Project. You will also learn how to update files on your
local machine and on the server automatically.

In order to build the iSeries Project, there are several steps you will need to learn
about and follow:

* Describe the build styles

* Select the build style

* Compile a single file

* Compile an iSeries Project

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Selecting the build style
* Submitting a build
* Running the program

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Selecting the build style
There are three IBM-supplied build styles:

*NONE
This build style contributes no actions and is useful if you want to disable
the menu items associated with a build style. This style will always be
available.

Command

This build style runs a single command in batch to compile all the

members of the project. The command can be configured through the build

style’s configuration page. This build style contributes the following three

actions to the Remote Actions menu found in the iSeries Projects Navigator

view:

* Push Changes — Pushes any new or changed resources found in the
selected project. An item is changed if it has been updated locally since
the last time it was pushed, either by Push Selected or Push Changes.
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The first time it is done, all resources are uploaded to the associated
library. Each subsequent upload is incremental.

* Push Selected — This action uploads all selected resources and their
children to their corresponding iSeries source files and members in the
associated library. It creates any resources that do not exist. It will
overwrite any changes that have been made on the host system only if
confirmed by the user. Use this action to force the contents of the
associated library to match the workspace.

Submit Build Command
Submits the command found in this build style configuration to the host.

CL Program
This build style uploads the COMPILE.CLLE and BIND.CLLE members
from the source file that you designated in the build style configuration for
this project. It then compiles and runs them to build this project on the
host system. This build style contributes the following actions to the
Remote Actions menu:

* Push Changes and Push Selected — These two actions are identical in
behavior to the above build style.

* Submit Build — Submits a job to compile and run the iSeries Project on
the host using the COMPILE and BIND programs from the source file
you specify.

Each iSeries Project can have only one active build style. This can be configured
through the properties page for that project (right click on the iSeries project and
select Properties).

By default, when a new iSeries project is created it has the CL Program build style
associated with it. This can be changed by going to Window > Preferences > iSeries
Projects > iSeries Build Styles.

Once submitted, a build can be monitored through the iSeries Build Status View.
This view can be set to update at regular intervals and monitors all iSeries Project
build jobs that you have submitted. Also compile errors can be retrieved from that
view by right clicking on the submitted build and selecting the Retrieve Errors
action.

Submitting a build

There are two ways by which you can compile your code changes. You can do a
single member compile on an individual member basis. Or you can compile the
full project. Compiling the full project depends on the Build Style associated with
the project.

Note: Choose to do a single member compile or a full project build but not both.

Submitting a single member compile
To do a single member compile:

1. Push the member to the host: in the iSeries Project Navigator, right-click on the
member and click Remote Actions > Push Selected on the pop-up menu.

2. Right-click on the member and select Show in Remote Systems View.
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This will compile your member and any errors will appear in the iSeries Error
List.

Make sure you refresh your view to see the generated objects.

Tip: When you connect the host using a Remote System Explorer connection,
the Library List is gathered from your profile at the host. You can override this
and modify the library list of a specific connection. Right-click the connection
in the Remote Systems view and click Properties > Subsystems > iSeries
Commands.

Submitting a full project build

You can compile the project in full. The actual compile behavior depends on the
Build Style associated with the project. The default build style for iSeries Projects is
the CL Program Build Style.

This build style will generate a COMPILE.CLLE member in a QCLSRC file that
will contain a compile entry for each source member in the iSeries project.

You can verify or change the configuration of a build style. You can specify the
name of the source file to hold the COMPILE.CLLE member and whether or not
you want to automatically push changes and re-generate the COMPILE.CLLE
member before a push.

For this exercise, all you have to do is simply submit the build.

To compile a project in full:
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Right-click any object in the iSeries Project and click Remote Actions > Submit

Build.
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This action, with the default configuration, will perform all of the following;:
a. Generate the following COMPILE.CLLE member:
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001000

4 of
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b. Display a Build Job entry in the iSeries Build Job Status View indicating that
a build has been submitted. The entry will look like this:

iSeries Build Job

Date/Timne Submitted

Status

Job | Project | Status
Feb 24, 2004 1:37:52 PM 154943(RICHIEYU/RICHL...  MyProject Queued
LI J__lReFresh Intenral Mewer

c. Push all project changes to the host, including the newly created
COMPILE.CLLE member.

d. Compile COMPILE.CLLE into a program in the QTEMP library.
e. Run it against the source in the RSELABxx library.
This will generate the program.

You can refresh your library view and now you should see an RPG program
object or a COBOL program object:

ect N v X
o |ed | S
- IEF PROMST *file.pf-dta (Remote) a

C E} QUMDSR.C, *file, pf-src (Remaoke)
-5 ORPGLESRCP.*file pf-src (Remote)
- [Ef REFMST *file.pf-dta (Remote)
' RSMMST. *file. pf-dta (Remote)

1’ CLCL. *pgm.clle (Remote)
58 cLrLpgm.clle (Remate)
MYCOMPILE *cmd {Remate)

- MYCOMPILE. *pam. clie (Remote.)

e [BD PP.\'ROLLD."‘pg'n.cbIe (Remote)
" #¥ PAYROLLG. *pam.rpgle (Remots)

|

iSeties Project Navigator |Mavigator |Bookmarks

2. If there where any errors during the submitted build, after the job completes,
refresh the iSeries Build Job Status View, then right-click on the entry in the
iSeries Build Job Status View, and select Retrieve Errors.

This will open the iSeries Error list and you will be able to double-click the
error to open the corresponding member.

Running the PAYROLL or PAYROLLC2 program

Communication between the iSeries and your workstation can be configured for:
1. The Remote System Explorer server job, the one that you are using currently.
2. A Dbatch job.

3. An interactive job to test 5250 applications.

You will need an interactive communication link to the iSeries server and therefore
you will need a 5250 emulator to start the interactive job on the iSeries. The
communication link will be established through the emulation session by using an
0S/400 command to initiate the session to your workstation.

To set up an interactive connection:
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Start a 5250-emulation session.
Sign-on to the iSeries with a User ID and Password.

Note: Instead of the Enter key, you may have to use the Ctrl key in your
5250-emulation session.

3. Type STRRSESVR NAME (s400a) RMTLOCNAME (*RESOLVE) in the command line.

Selection or command

==> STRRSESVR NAME (s400a) RMTLOCNAME (xRESOLVE)

The *RESOLVE keyword will get the IP address of your workstation and with
this information the Remote System Explorer server will communicate with the
Remote System Explorer daemon that runs on your workstation.

You should see a screen as shown:

IBM RSE Communications Server

Connection Name: s400a

(c) Copyright IBM corp., 2001, 2003. All rights reserved.

Note: This screen will stay this way. Don’t wait for it to finish, this session is
the interactive session for interactive commands started from the Remote
Systems view.

Next you will run the program that you just compiled earlier.

Select the program object in the iSeries Projects Navigator, right-click to see the
pop-up menu and then click Show in Remote Systems View.
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In the Remote Systems view, in the RSELABxx library:
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1. Locate the PAYROLL program or PAYROLLC2 program that you created.

2. Right-click the PAYROLL program icon or PAYROLLC2 program icon in the
Remote Systems view.

3. Click Run > Interactive on the pop-up menu.
4. Switch to your 5250-emulation session.
You will see the Start Menu of the payroll program.

Place an x beside Employee Master Maintenance.

Press the Enter key.
Type 456 for the Employee Number.
Type A for the Action Code to add employee 456.

© o N o g

Press the Enter key.

10. Type any information you like about the employee.
11. Press the Enter key.

12. Play in the application as much as you like.

13. Press F3 to end the program.
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Recap

Congratulations! You have completed this module. You should now understand:
* The concept of build styles

* How to select a build style

* The difference between a single member build and a full project build

* How to submit a build

* How to run an interactive application

Now that you have built your iSeries project, you can move on to designing
screens. Continue to the next module.
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Chapter 9. Designing screens

In this module, you will become familiar with the various aspects of the CODE
Designer while modifying a display file to add a screen. You will step through
each part of the CODE Designer tool interface and update some DDS as well. In
the workbench, in the Remote System Explorer perspective you will use the
connection that you used in the module before.

In order to design screens, there are several steps you will need to learn about and
follow:

* Describe the features of the CODE Designer
* Start the CODE Designer

* Open, modify and save a display file

e Add a group

e Add a record

* Add, delete and modify various DDS fields
* Verify DDS

¢ Compile DDS

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Opening a DDS member

* Viewing the DDS tree

* Selecting the DDS object

* Designing your DDS screen

* Creating groups from existing records

* Creating new screens

* Adding fields to the subfile record

* Switching between multiple records

* Adding field error handling

* Accessing field properties

* Adding new keywords

* Verifying your source changes

* Switching between design and editing your screen
* Compiling your source changes and closing CODE Designer

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 30 minutes to complete.

© Copyright IBM Corp. 2001, 2004 79



Opening a DDS member

Using an editor to create and maintain DDS source for your display and printer
files can be a frustrating and difficult task. What would be great is a graphical
design tool that let’s you design your screens and reports visually and then
generate the DDS source for you. Well, that’s exactly what CODE Designer does

for you.

CODE Designer helps the novice DDS programmer create screens, reports and
databases quickly and easily without worrying about the details of the DDS
language, while at the same time letting the expert DDS programmer get access to
all the features and power of the language.

Note: Make sure MSTDSP is closed from a previous LPEX Editor exercise.

To open a DDS file member:

1. In the iSeries Project Navigator, expand QDDSSRC.

* 4 iseries Project v x || ACOMPLECUE | Frawrolcz X

’ + R 9 Col 1 I

b || S o I___+_*;’_1“_"]‘3’1_+____2_r13_5_
=-{z= MyProject

E‘E‘ QCBLLESRC (Local/Remate) 000001 PROCESS APOST.
@-BY QeLsre (LocalfRemote) LNC1904: Program PAYROL!
=-E§ QODSERC {LocaljRemats) 000002
i [5° EMPMST.PF (Local{Remote) 0oo0oo3 IDENTIFICATION D
. @ n nnann
0 PROMST.E e J E PROGRAM-ID.
[ REFMST.PF o oPET ATTTHOR .
0% ranmsT.pr I *| ® "} CODE pesigner
; ,__';;"H MVEMPMST.|  show In Remate Systems Yiew {45 CODE Blitor

2. Right-click MSTDSP member.

3. Click Open With > CODE Designer on the pop-up menu.

Viewing the DDS tree

What you are looking at now is basically an explorer view of the DDS. The DDS
Tree view on the left-hand side of the Designer displays the DDS source in its file,
record, field, and keyword hierarchy. It is a familiar and intuitive way to see the
overall structure of the DDS source and to navigate through it quickly. Don’t worry
if you're not a DDS expert, we will explain everything you need to know.

The DDS Tree is located on the left-hand side of the CODE Designer window. This
view presents the loaded DDS source as a tree structure, showing the hierarchy of
files, records, fields, help specifications, keys, and keywords in each selected DDS
object. The DDS Tree shows groups of records, which represent the screens or
reports you are designing, as peers of the file in the tree hierarchy.

In this view, you can create groups, and copy or move keys, keywords, fields, and
records. If any DDS object contains an error, the icon representing it displays a red

X.

To open selection in the DDS tree to see file-level keywords and the record

SELECT:

1. Expand the local folder.

2. Expand the File Keywords folder.
3. Expand the SELECT record.
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4. Expand the Record Keywords folder.
5. Expand the EMESS field.

The DDS tree now shows you a summary of the file-level keywords and of the
record SELECT.

Selecting the DDS object

In the upper right-hand side of the Designer is the Workbook with several different
tabbed pages. The Workbook is the area of the CODE Designer where you design
display files or printer files. You can view this notebook on the top right-hand side
of the CODE Designer window. The top page is called Details and it provides a
detailed view of the DDS objects selected by the DDS Tree. You can view this page
in either details mode or list mode by selecting View > List.

In details mode, columns display information about each DDS object. You can use
this mode if you want to know more about each DDS object (record, help
specification, field, keyword, or keys).

In list mode, the DDS objects appear as columns of named icons. You can use this
mode if you want to see more DDS objects within the page.

In the bottom right-hand side of the Designer is the Utility notebook. It lets you
view specific elements of the DDS source such as errors and selected objects. The
notebook contains several views: Selected DDS page, Error List page, Create
keywords page, and Comments page. The Selected DDS page in the notebook
shows the actual DDS source for the currently selected item.

To work with the DDS record SELECT:
1. In the DDS tree click the SELECT record.

The Details page lists all the fields in the record SELECT and summarizes some
of their properties. The Selected DDS page shows the DDS for the SELECT
record.

Details | MAIN_MENU | Source | Listing|

Fecord SELECT fields
Field | Positi.. [ Len.. | Type | Shift | Usa... | Sample -
A 'PRGOT 2.5 5 Text congt... PRGOT
A Time R.. System’ 2,30 21 Text const... Time Reporting Spste
@“DATE 270 B Date const... MM DDA
A Mainte.._ection’ 33 A Text const... taintenance Selectic
@"TIME 370 6 Time const... HH:MM 55
A Enter ..intair' 614 54 Text const... Enter an ¥ beside the
I EMPAPL 3.25 1 Alphanumenc A - Alphanum... Both B
A Employ.. enance’ 9,28 27 Text const... Employee Master Mai
[ PRJAPL 10,25 1 Alphanumenc A - Alphanum... Both B
A Frojec. enance' 10,28 26 Text const... Project Master Mairte
‘ﬁ RSNAPL 11,25 1 Alphanumeric A - Alphanum... | Both B R h

2. In the DDS tree click Record keywords immediately below SELECT.

The Details page shows the current record-level keywords. The Selected DDS
page still shows the DDS for the SELECT record.

3. In the DDS tree click the EMESS field.
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The Details page shows its field-level keywords. The Selected DDS page now
shows the DDS for the EMESS field.

Selected DDS | Create kepwords | Web Settings | Comments | Eror lst |

<

A EMESS 502 0O 21 16 :I
A& B0 DSPATR(HI)

< o

Even this relatively small and simple DDS source member demonstrates how
much easier it is to use the Designer to navigate through your DDS source. The
syntax is being interpreted in intuitive graphical ways making it an ideal tool
for learning DDS. But to get orders of magnitude improvement in your
productivity what you really need is to work with your screens and reports in
a WYSIWYG fashion, completely oblivious to the DDS required to make things
appear the way they do. You need the Design Page.

Designing the DDS screen

82

You will spend most of your time creating, updating, and designing your DDS
screens and reports in the Design page. The Design pages allow you to design
your screens or reports visually using an intuitive graphical user interface. The
Design page shows the DDS source as it would appear on either a screen (for
display files) or a printed page (for printer files). It allows you to design your
application’s screens or reports by laying out records and fields in a graphical user
interface.

On the Design page, you can easily create, edit, resize, and move DDS objects
graphically. Create new records, fields, and constants directly on the Design page
by using the palette push buttons to the left of the Design area or from the pop-up
menus. The toolbar above the Design area allows quick access to many of the
editing features as well as information about the currently selected object.

Click the MAIN_MENU tab in the workbook.

Detais QAIN_MENDY Source | Listing |
(&) [Eserec M ERD

| %I Ignore all indicators

1he 4ppl cation pog want 1o nantant

=)

In order to understand where MAIN_MENU came from, we need to describe the
concept of a group. A group is simply a collection of one or more DDS records that
represent how a screen or report would be assembled at runtime. It allows you at
development time to work with screens or reports as they would appear when
they get assembled by your programs at runtime. To work with groups in CODE
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designer you need to tell CODE designer which record formats make up a screen.
In this case we have done this for the screen you see in the design page. We have
created a group MAIN_Menu and CODE designer saved this information in the
DDS source in comment lines. Any groups that you create are persisted as
comment lines in the DDS so you can re-use these groups in subsequent CODE
designer sessions.

The groups you create will appear in the tree view as well as in the workbook as a
Design page tab for each group defined, to allow quick access to each group of
records.

Creating groups from existing records

If you are working with existing DDS, you will want to create groups that will
correspond to how the records are being used. In this example you will create a
group for the next screen, where the user selects which employee in the payroll
database to maintain. The screen is made up of record format EMPSEL.

To create a new group:
1. Scroll to the bottom of the DDS tree and expand the MAIN_MENU group.
The SELECT record appears as the only record in this group.

-8 MAIN_MENU

= @ B

2. Right-click the MAIN-MENU group.
3. Click Insert group on the pop-up menu.

A Group Properties notebook opens and a blank Design page for the group
SCREENT also opens.

[ Detaie | MAIN_MENIKGCREER I S owce | Lising |
z,, 3 ; L

ISCHEENI

Available

EMPSEL
EMPMNT

PRJSEL >

PRJMNT —,
RSN

Selected DDS | web Seltings | Comment | Rensiny «|

i 1 i

The Properties notebook lets you view and update the properties of the
currently selected DDS object. You can open this notebook from any view,
pop-up menu, or menu of the CODE Designer. The properties notebook is
modeless. When you change an object’s properties, the selected object changes
immediately.

4. In the Group Properties notebook, select EMPSEL record from the Available list
and click the _» | button.
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For simplicity this is the only record you will add for now. The Design page
now shows us what the record EMPSEL looks like.

[ [@EJemese MERQ]

|grote all ndcators :I

5. In the group field, type EMPL_SELCT over SCREEN1 to rename the group.

[ Group properties . ﬂll
Basics I Styles |

Avallable Selected
SELECT

EMPSEL
EMPMNT
PRJSEL

PRIMNT
RSNSEL
RSNMNT

o I

6. Close the Group properties notebook. Click the X in the top right corner of the
Group Properties notebook.

You have finished creating a group. You could now work in the Design page
with the record formats contained in this group. Now you’ll create a new
record format.

It appears that this is one of those unusable applications where you have to
know the employee number ahead of time instead of being able to browse
what is in the database. What we really need is a subfile. But aren’t those
difficult to code, you ask? Not with CODE Designer.

Creating new screens

84

To create a new record screen on the Design page you need to create a group that
will create an empty page you can work with.

To create a new group:
1. Right-click the new EMPL_SELCT group in the DDS tree.
2. Click Insert group on the pop-up menu.
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A Group Properties notebook appears and a blank Design page for the group
SCREENT1 also appears.

[

iz

E%glg“lf all indicators

[SCREENT
Avalable Selected

SELECT

EMPSEL

EMPMNT

PRJSEL 5 |

PRJMNT

RSNSEL

RSNMNT L’

Selected DDS | Wb Setlings | Conme

%_

g

3. Rename the group to EMPL_LIST and close the Group Properties notebook.

4. You can create things on the Design page by selecting the appropriate tool from
the palette on the left-hand side and then click on the Design page where you
want it to be created. Right now, most things are disabled in the palette
because there is no record in which to create fields. The only two tools
available are Create standard record and Create subfile record. If you leave
the mouse over a button for a second or two, flyover help will appear
describing the indicated button.

Details | MAIN_MENU | EMP_SEom:e| Listing |

_______________________

5. Click the Create subfile record button and then click in the dark gray area.
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A subfile and a subfile control record pair are created.

Details| MAIN_MENU | EMP_SELCT EMPL_UIST | Source | L|st|ng|

(&) [EgJrecoro | |4|»|[
’:'Iglueel ndicators

il
3
4
5
]
i

Adding fields to the subfile record

86

Now you add some columns to the subfile using the Design page. The subfile
should be positioned on row eight. You use the cursor to specify the location of the
part you want to put on the screen, in this case your subfile.

To add fields on the subfile:

1. Click Create named field button = and then click somewhere on row 8.

Six fields appear in a vertical column. This is because the subfile you created,
currently specified a SFLPAGE (visible list size) of six.

2. Click the top field and hold the mouse button down and move it to row 8,
column 5.

Note the current row and column appear just above the field as you move it.

3. Move the cursor over to the right edge of the field. It turns into a
double-headed arrow. Hold down the mouse button and move it to the left.
The size of the field will be reduced. The current size will appear just above the
field. When the size is 3, let go of the mouse.

The toolbar at the top of the Design page is a very convenient place to monitor
and manipulate the currently selected parts.

4. Rename the record from RECORD1 to EMPLSTSFL and the field from FIELDI1 to
OPCODE by typing over the text in each list.

) [BEvrsTsr ) el ][> Korcooe J“;l @E -
Eﬂlgnme all indicators j g

5. Click the Color palette EHI button and select pink to change the color of the
field.
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To create an additional column:

1.

Click the |Z] button to change the usage of the field to input.
Now you will create an additional column in the subfile.

Position the cursor at row 8, column 9.

Note: The bottom right of the CODE Designer window shows the current

cursor position i

If you can’t see the field with the cursor position on your screen, click the
Maximize button in the top right corner of the screen. You can use the cursor
keys or the mouse to move the cursor.

If you are creating a long field with an exact length, the SDA syntax can be
easier. Type:

+0(30)

and then press the back arrow (not Backspace!) to select the text you created.

Notice from the Selected DDS page that you have created a text constant
containing +0(30).

Click Convert string to field & button on the toolbar or press F11 to convert
the SDA syntax into a character output field of length 30.

JemPLSTSFL ﬂl‘ﬁl*'lrl!'wmr Jl:“_EXj%f_j -@

llgnue all indicators

Rename the new field to ENAME using the toolbar. This will show the name of
the employee.

@EMPIST SFL
-Imole all indicators

(=] = E z]o[e] (=1
esfes)e = [0 E[E.'E!Fﬁ' E

Position the cursor to 8, 41.
Now you will add a field for the employee’s salary. Type
$666,666.66

and then press the back arrow.

Now wouldn’t it be better if we could just tell the Designer what we wanted
the number to look like and then have Designer generate all the cryptic
EDTCDE:s to make it happen?

Press F11 to convert this field into an output numeric field with comma
delimiters, two decimal positions, a currency symbol and no sign. Look at the
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Selected DDS page to see what was generated for you. Impressive!

Detais | MAIN_MENU | EMPL_SELCT EM wce] Llsllngl

I ESE— .EL‘! BALARY]

Ll larore allindicators

clected DD ] Web Settings | Comments | Eror list |
S

| EA SALARY 8Y 20 & 41EDTCDE(1 SE -

9. Rename the field to SALARY and change its color to yellow, using the toolbar.

10. The subfile seems compacted to the left. It would be better to space it out

evenly. Just select the field and click the space horizontally # button on the
far right side of the toolbar. The other alignment buttons will align fields, left,
right, center and top.

mEfevrstsre  lfEe]x] ]S [P E -
@lgmreallindicatnrs J-éldlf' | 2 E E

Just below the palette there are three spin buttons. The top one, Subfile size,
specifies the total number of entries in the list that will be filled in by the
application. The second one, Subfile page size, is how many entries appear
on the screen.

11. In the Subfile size field, type 300.
12. In the Subfile page size field, type 9.

Details | MAIN_MENU | EMPL_SELCT EMPL_LIST |‘3wrc‘e| Listing |

7Y S e = ||
@ Ignore all indicatons
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The Design page is updated accordingly.

Switching between multiple records

Now let’s fix up the Subfile control record. The group you created contains 2
records. You can verify this by looking at the record list in the toolbar:

RECORDICTL

1. Change the current record by selecting RECORD1CTL from the record list or
click next record #| or press Alt+End.

The fields in the subfile still appear so that column heading can be lined up,
but they appear at half-intensity so that they can be distinguished from the
fields of the current record.

2. Rename the record to EMPLSTCTL using the toolbar. Let’s provide a "position to’
entry in the subfile control header.

3. Position the cursor at 4, 9 and type:
Position to:

Detais WP_SELET EMPL_LIST | Source | Listing|
@) @&evrestae =[S« =i

=

4. Now you need an employee name field.

You could create a named field with the right characteristics like you did in the
subfile, or you could create a source reference using the Create source reference

field £l button in the palette or you could reference the original database field

using one of the Create database reference field B Create database reference

and paste!
5. In the DDS tree expand the EMPMNT record.
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6. Click the ENAME field and press Ctrl+C.

(=) ﬂR‘1-5400Fl.)RSEL#EJ’QDDSSRC(MSTDSP):
+- 2= File Keywords
48 SELECT
+| - e
[+-jo= Record Keywords
- A 'PRE0O1
F-A 'Time R...System’
-0y *0aTE
B *TIME
#- A 'Employ...enance
[+ "Mumber'
0, emPrO

[+ A Careqory’
-G, EMCAT

[+ A 'Department’
-G, EDEPT

[+ 'Location'
=0, ELocy
#-A "USRID'

[+ B EUSRI
#-A 'Mormal,.. hours' —
=B, ENHRS

(The pop-up menu or Edit menu shows the Copy menu item as well).
7. Position the cursor to 4, 23 and press Ctrl+V. Now that was easy!
8. Rename the field to POS_TO.

Detais | MAIN_MENU | EMP_SELCT EMPWCE' Listing |
@ @evrstare =[S <l [Pos_To J ][] [0 H (1
@Ignulz all indicatars 3 @ 2 : E'I..‘-\i_ldlrbl
2 + +

e F BN  EFmmE | S 6 S | e e T--m=t----8

Adding field error handling

90

Let’s put in some error handling for the "position to employee name’ field. If the
employee name is not found in the database, the program will turn on indicator
60. An indicator is a two digit variable (01, 02, 03, ... 98, 99) to signal whether or
not certain events have occurred during processing. Using indicators enables
program events to control screen displays. These indicators are set ‘on”” or “off” in
one part of the program while their status is referenced in another part of the
program. By setting the indicators ‘on” or ‘off’, you can associate fields with
indicators to control whether or not a field will appear on the screen.
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The screen should turn the field red, reverse image and position the cursor to it.

Now wouldn't it be better if we could work something higher level and easier to

remember than some arbitrary number from 1 to 99.

To set indicators:

1. Click the Changed named indicator sets “| button on the Design page toolbar

(or press F7).

The Named indicator sets window opens.
In the Settings name field, type: Not Found.
Click Create.

Named indicator sets x|
Indicators

-0 20" 30T 40 50 60 70T 80T ad
iR iR mica R iR iR iR mici R mial mie: iR il
- 0212 22 321 421 62 621 72J 6827 92
| il el it mivecl il mitecl milcl mivch mik: o mik: =
T 04T 1A 24 24 4 G4 64 74 84 o4
05 s 25 B E 45 55 65 75 65T 95
T os 16 26 36 46 56 66 760 6617 96
0P i 27 3 47 57 6P 77T 67 97
[C o8 181 28T 38 481 B8 GBI 781 881 398
i 03T ST 29T 3e T a9 T Bl BE T 7A T 8T 93

Checked indicators are: & [ & Off

Create |
Hename |

Delete

&DDIyI Camell Help |

Select the check box next to 60 and click OK.
The Not found indicator set is now in effect. The Design area is shown as if
indicator 60 was on and all other indicators were off. The Design page toolbar

shows the current indicator set in the Select named indicator set list on the
bottom left.

T S ﬂ|s§|q|p||ms_ﬂ3 =[€]
Now select the POS_TO field.

On the toolbar, select the color red and the display attributes reverse image
and position cursor. (The set of toolbar buttons representing the current
display attributes is found just below the color button).

Settings namé INot Found )

lgnore all indicators
All indic off

The toolbar should look as follows:

= A [ el
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7. Examine the DDS generated in the Selected DDS page.

Selected DDS IWeb Settings | Comments | Errorlist |

A FOS_TO R E 4 23
A 60 COLOR(RED)
Iy REFFLD { RCEMP~ENAME *LIEL-El
A 90 DSPATR(FR)
L &0 DSEATR(RI )
i 60 DSPATR(FC)
Kl

Notice that all the new keywords were created with a condition of 60. (The
DSPATR(PR) was pasted with the field originally).

8. Now let’s try it out! From the Select named indicator sets list, select All
indicators are off.

mEer e SIE] [ (ofe) ) ¢
&ll indicators are off - AJI E (, i J': E .

Wow! This really works!

9. From the Select named indicator sets list, select Not found.

The field appears red and reverse imaged.

Accessing field properties

Second to the direct manipulation and the toolbar on the Design page, the easiest
and quickest ways of getting access to the properties of a field, record, or entire file
is a Properties notebook.

The Properties notebook lets you view and update the properties of the currently
selected DDS object. You can open this notebook from any view, pop-up menu, or

menu of the CODE Designer.

The Properties notebook is modeless. When you change an object’s properties, the
selected object changes immediately.

You can get to a Properties notebook from the Selected menu, by pressing F4, or
double-click on anything in the DDS tree or the Details page or Design page.

To open the Properties notebook:
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1. In the DDS tree, click the record SELECT and press F4 to see the Record
properties.

21X

|*& Record propetties

{ Basics || CA/CF | Styles |
Record |5ELEET
Type |Standard

Madified IEBFZSI’SZ
Mumber of fields |14 [ Ina window

Description |

As you select different items, the Properties notebook will continuously update
itself to show you the properties of the selected item.

2. Click the *DATE field in the SELECT record. (You may have to move the
Properties notebook out of the way.) This field has a different set of pages
describing its properties.

3. Change the year from 2 to 4 digits. Select the Length of year check box.

4. Select 4 digits from the list.

Eii Field properties
Basics | Atiibutes | Color | Ediing | Indicators |

Sample I~ Source of date | = |
[MM/DDAYYY C!v‘ Length of year m

Pasition
Size  Row  Calumn

24XBU| 2E| ?UE
2?'.><2132| _'EI EE

Description |

Notice how the sample is updated on the Properties notebook.

5. To test the Design page, click the MAIN_MENU tab in the workbook and look
at the upper right corner of the screen. The year now has 4 digits.

6. Click the EMPAPL field in the SELECT record. On the Field properties
notebook click the Basics tab.

On this page you can change the field’s name, usage, length, type, and screen
position. The other pages give you quick access to other properties for this
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21x
Field ype
|EMPAPL : _‘ | [
Lizage
HEECE IA Abharmem =
Length————————  Position————————
Total Dec Size  Row  Column

| | 2ee [ o= 25
[~ Continued (CNTFLD) 27,<1::2| LE| EE
H

Wwidth

Description |

Adding new keywords

CODE Designer helps you manage the visual aspects of your displays and reports.
But you also need to access the full power of DDS. You need to access keywords.

To add keywords:
1. Click EMPAPL field in the DDS tree.
2. Press F5 or right-click and click Insert keywords on the pop-up menu.

B l__I <R454004>RSELABIQDDSSR: 4] | Detals MAlN_MENU ]

ords

ecord Keywords - Ignore all indice

L A 'PRGOL
L A 'Time R...System’
=@ *Date
E: -2 'Mainte, . .ection'

- *TIME

- o2y Insert Field
O prIApL Insert help specfication  Alt+H
#-A Projec,
RSMAPL
E ? 'Reasor etk Chrh+x
- Emess oY Ctr+C
A F3End  pelete CirhiDel
D & EMPSEL Dupiicate o
[+ 43 EMPMNT
- [-48 PRISEL Move up Ctri+Up
4@ PRIMNT Move down Ctrl+Dawn
§ g Eg:l?,‘i;- Properties F4

You see the Details page for the EMPAPL field and the Create keywords tab is
selected in the Utilities notebook. This page shows you the subset of keywords
that are allowed for the selected file, record or field and it takes into account
the field’s type, usage, shift and what record it is in. It is very powerful to
know exactly what your options are. This information cannot be quickly
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ascertained from the Reference manual.

Selected DDS  Create keywords |Web Settings | Comments | Ermor list |

Insert | Subset IAI j
S B |45 S« CHECKM11)  S«CHRID SwFLDCSRPRG S~WRDWRAP
S BLANKS T CHECK(M10F) @CULUF%» S |GCALTTYP S INKNOWN>
(S~ CHANGE S CHECK[M11F) S COMP S INDTART 55>

owCHECK(AB]  ©wCHECK(RB)  ©wDFT SwMSEID3»>

>« CHECK[ER] S CHECK(RL) S DFTYAL S NOCCSID

[« CHECK[FE) S CHECK[RZ) @ DSPATR»>> S OVRATR

(&« CHECK[LC) S CHECK[VN) S« DUP S OVRDTA

S CHECK([ME) S~ CHECK(VME) S~ ENTFLDATR S~ PUTRETAIN

S CHECK[MF) S CHGINPDFT S ERAMSGy>> S RANGE

(S~ CHECK[M10) S CHKMSGID S« ERRMSGID>»> T\l UES

4] | i3

3. With the EMPAPL Properties notebook at the Basics page, click the numeric
field [& button to change the field to numeric type.

W Field prnpertles ﬂil
Field ype
[EMPAPL ; _: o8
Usage "
HE G0 E0 IA T W
Lcu_.lul Position
Total Dec Size  Row  Column
[ H B | e[ &= 258
[~ Continued [CNTFLD] E_F-‘HEI_EEI_EE
wWidth

Description |

Notice that the list of keywords in the Create keywords page has changed.

Click the & button to change the field back to alphanumeric.

Notice that the list of keywords in the Create keywords page has changed.
Click the ALIAS keyword and press F1.

The DDS Reference help for the ALIAS keyword appears.

Tip: CODE Designer has lots of on-line help. Press F1 anywhere you want to

see help for an item, icon or notebook. You will get help relevant to what you
are currently trying to do. From the Help menu you can get quick access to the
DDS Language Reference as well as several other useful sources of information.

Minimize the Help window.

Double-click the INDTXT keyword. (You may have to scroll to the right to find

it).

The keyword is created with default values which can be changed when you
want.

Double-click the INDTXT keyword again.

The keyword is created with the same default values creating a conflict.
Close the Keyword Properties dialog.
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Verifying the source changes

You have just added a new record and some new fields to our DDS source.
Everything that the CODE Designer adds to your DDS source is certain to have the
correct syntax. Now you need to make sure that there are no semantic errors. You
just introduced one in the last section by creating two INDTXT keywords
describing the same indicator.

To verify your source:

1. Click Tools > Verify file (or click the verify M button on the main toolbar) on
the CODE Designer menu.

The DDS source is checked using the same verifier that the CODE Editor or
LPEX Editor uses. A message appears on the status line at the bottom of the
Designer stating that the verify process completed with errors.

2. In the DDS tree, there is a trail of red x’s leading to the problem.

B"@ <R15400A =RSELABXXQDDSSR
. [# o= File Keywords
| =4 SELECT
- a Record Keywords
i E A 'PRGOL
. @A TimeR,..System'
- @-[@y *oate
. ®-A Mainte, , ection’
LB rTIvE
#-Z 'Enter .. inkain’
=
L e INDTHT
| .Cyg INDTXT
. @A ‘Emplay...enance’
- PRIAFL
. #-A Projec...enance’
3 RSMAPRL
. [#-A 'Reason...enance’
| -3 EMESS

The file icon has a red x, as does the SELECT record, the EMPAPL field and
finally the second INDTXT keyword.

3. Click the MAIN_MENU tab in the workbook.
The EMPAPL field is highlighted in red.

4. Click the Listing tab in the workbook.

This page shows you the listing generated by the most recent program verify. A
warning message is buried somewhere in the listing but it’s not easy to find.

5. If there are problems, they will show up in the Error list page in the Utility
notebook. It behaves exactly like the Error list in the CODE Editor or LPEX
Editor. Click the Error list tab.

6. Double-click the warning DDS7861 in the Error list. (Press F1 to see detailed
help on the message).

The Source page appears and the cursor is placed exactly where the error is in
the source. The Source page is a tokenized read-only view of the current state
of the DDS source. Read-only? Wouldn't it be great if you could just clear the
error right here. There are some things that are just plain faster in the editor
and many others that are faster in the visual environment. It would be great to
switch between the two modes at the push of a button. Well, let’s just do that.

Switching between designing and editing the screen

To switch between the Design mode and the Edit mode:
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1. Click the Edit DDS source B button or select File > Edit DDS Source from

the Editor menu.

You now have access to the full power of the editor.

2. Explore the Edit and View menu items.
3. Press Ctrl-F to open the Find/Replace window.
4. In the Find field, type INDTXT and click Find.

Editor - Find and Replace x|
Find INDTXT ﬂ
Replace with |
& Replace this occurrence ¥ Case sensitive
" Replace, then find next [~ Pattern match
¢ Replace all occurrences ¢ Yrap
i
m Replace Options... I Cancel I Help
5. Press Ctrl-N to find the next occurrence.
6. Delete the second INDTXT line.
File | Edit View Insert Selecred  Tools Help
r Undo Chrl+2 g
= q @)
Cut Ctrl+x
Sou - copy CtrHC
{%ﬁ Paste Chrly
no Delete CirkDel Eplace Elnctiun5+++++++ﬂ
829 Duplicate CurkD 6 14'Enter an X beside
830  select 4l Chrl+a you want to maint:
831 Deselect all JPL 1 B 9 25IHDTET(O1 "7?°)
832
038  Find andreplace.., Ctr4F 9 28'Employee Master |
gg; Find next shife+Fs  JPL LU :g gg.P ct Haster M
Find uj ChelL rojec daster <
a6 P ! PL 19 B 11 25
837 - “1 28'Reason Code Haste
vos BENY voine AR | G
= I Locate »  Markcharacter Alt+B
Set quick mark. ChrHQ Mark rectangle  Al+R
k &
[ pomw 4 il
Efra I:sert prompt CurkF4 Move Alt+M

alt+D

Ale+C

Compiling your source changes and closing the Designer

Now you will compile the source on the iSeries just as you did in the Remote

Systems LPEX Editor and then close the designer.

To compile your source:

1. Click File > Save from the Designer menu to save your source to the iSeries.

2. Click Tools > Compile from the Designer menu and then click No prompt (or
click the compile #| button on the CODE Designer toolbar).
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3. A message indicates when the compile is complete. Click OK in the Message
window. If you run the PAYROLL program, you will see the 4 digit year
change you made to the opening screen of the program.

To close the Designer:

1. Click File > Exit from the Designer menu.

Checkpoint

98

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. There is a graphical design tool that let’s you design your screens and reports
visually and then generate the DDS source for you. This tool is named:

a.
b.
c.
d.

Page Designer
CODE Designer
Screen Design Aid
None of the above

2. Match the item with its correct description.

o0 oo o

Workbook

Details page

Utility notebook

Design page

View specific elements of the DDS source such as errors and selected objects
Lists the contents of the currently selected item in the DDS tree

Contains several different tabbed pages

For visually designing screens and reports

3. The Utility notebook contains:

® a0 o

Selected DDS page
Error List page

Create keywords page
Comments page

All of the above

4. On the Design page, you can easily:

a. Create DDS objects
b. Edit DDS objects

C. Resize DDS objects
d.
e
f
g

Move DDS objects

. Create records

. Create fields

. Create constants
h.

All of the above

5. Grouping records together allows you to work on one record while still seeing
the related records in the background. (T, F)

6. The Properties notebook is modeless. When you change an object’s properties,
the selected object changes immediately. (T, F)

7. The DDS source is checked using the same verifier that the LPEX Editor or
CODE Editor uses. (T, F)
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8. You can switch between design mode and edit mode in CODE Designer. (T, F)

9. You can compile sources on the iSeries just as you can in the LPEX Editor. (T,
F)

More practice

Want more practice? Try this!

Given your experience in this exercise using the CODE Designer, try creating a
printer report. You can use the physical file specification REFMST in member
QDDSSRC in library RSELABXX. Take time to explore the fields and information
for this physical file. You may want to refer back to this information as you create
your report. When you are familiar with the file REFMST, you can create your
printer file. Use the Development Studio Client for iSeries online help to assist you
in this task.

Recap

Congratulations! You have completed this module. You should now understand:

* The purpose of a workbook, details page, utility notebook, design page,
properties notebook, group and indicator

* How to modify a display file to add a screen
* How to add groups, records and fields

* How to save your DDS source

* How to verify your DDS source changes

* How to compile your DDS source changes

Now that you know how to design screens, you can learn how to debug and test
the payroll application on an iSeries system. Continue with the next module.
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Chapter 10. Debugging a program

In this module, you will review the Debugger features. You then learn how to start

the debugger, set breakpoints, monitor variables, run and step into a program,

view the call stack in the Debug view, remove a breakpoint, add a storage monitor,

and set watch breakpoints and all from the Debug perspective.

In order to debug a program, there are several steps you will need to learn about

and follow:

* Describe some of the features of the Debugger
 Start a Debug session

¢ Add and delete line breakpoints

* Display a variable

¢ Change a variable

* View the call stack

* Run, step and step into a program

* Switch between source and listing view
* Add a storage monitor

* Add a watch breakpoint

In order to accomplish these learning objectives, there are several steps that are

involved, including:

* Debugging iSeries programs from the Debug perspective

* Starting the Integrated Debugger

* Setting breakpoints

* Monitoring variables

* Stepping into a program

* Listing call stack entries

¢ Setting breakpoints in PAYROLLG or PAYROLLD

* Removing a breakpoint in PAYROLLG or PAYROLLD
* Monitoring variables in PAYROLLG or PAYROLLD
* Adding a storage monitor

* Setting watch breakpoints

* Closing the debug session

The exercises within this module must be completed in order. Start with the first

exercise when you are ready to begin.

Length of time:

This module will take approximately 20 minutes to complete.

Introducing the iSeries Integrated Debugger

The Integrated Debugger is a source-level debugger that enables you to debug and
test an application that is running on an iSeries system. It provides a functionally

rich interactive graphical interface that allows you to:

© Copyright IBM Corp. 2001, 2004
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View source code or compiler listings, while the program is running on the
iSeries system.

Set, change, delete, enable and disable line breakpoints in the application
program. You can easily manage all your breakpoints using the Breakpoints
view.

Set watch breakpoints to make the program stop whenever a specified variable
changes.

View the call stack of your program in the Debug view. As you debug, the call
stack gets updated dynamically. You can view the source of any debug program
by clicking on its call stack entry.

Step through your code one line at a time.
Step into or step over program calls and ILE procedure calls.

Display a variable and its value in the Monitors view. The value can easily be
changed to see the effect on the program’s execution.

Locate procedure calls in a large program quickly and easily using the
Modules/Programs view.

Debug multithreaded applications, maintaining separate stacks for each thread
with the ability to enable and disable any individual thread.

Load source from the workstation instead of the iSeries — useful if you don’t
want the source code on a production machine.

Debug client/server and distributed applications.

The Debugger supports RPG/ 400® and ILE RPG, COBOL and ILE COBOL, C, C++
and CL.

In the following exercise you will be given the opportunity to learn about some of
the basic features of the Debugger. For the purpose of this exercise you will debug
an ILE RPG/400 program. Don’t worry if you don’t know RPG.

Starting the integrated debugger
You will be working with the ILE RPG program PAYROLLG.

102

Note: For RPG programmers: PAYROLLG is the same RPG program as PAYROLL

but without compile errors. You are using it instead of PAYROLL in this
exercise, to accommodate anyone who decided to skip right to this exercise
without completing the editor exercise.

Note: For COBOL programmers: PAYROLLD is the same COBOL program as

PAYROLLC but without compile errors. You are using it instead of
PAYROLLC in this exercise, to accommodate anyone who decided to skip
right to this exercise without completing the editor exercise.

Note: Make sure that your user ID has been setup, so that your library has been

added to the library list automatically. You can use the properties for iSeries
Objects dialog to set connection information such as adding a library to a
library list and changing the current library. You can right-click on iSeries
Objects then click Properties to see this dialog. You will need this setup to
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run jobs interactively from your workstation.

&P Properties for iSeries Objects =10f x|

Command Execution Initial Library List
Environment Yariables

—Library list

Subsyst
ubsystem Ubrary: |
Remove I

Librar Library Position

RSELABX (CFIRST )

Current library: | "USRPRF |

Initial command:

c ICHGCURLIB RSELABRK D

Restore Defaults | Apply I

.

You can start the Debugger in several ways: directly from the pop-up menu of a
program or service program in the Remote Systems view, or from the Launch
Configurations window. Starting directly from the Remote Systems view doesn’t
allow you to specify parameters to be passed to the program. The Launch
Configurations window allows you to modify how the program is invoked and to
specify parameters.

To make the exercise interesting you will use CL program CLR1 to call PAYROLLG
and you will pass one parameter to CLR1 or you will use CL program CLC1 to
call PAYROLLD and you will pass one parameter to CLC1. This means you will
use the Launch Configurations window.

To start the debugger:
1. Expand QCLESRC in the iSeries Projects Navigator.
. Select program CLR1 or CLCI.

2
3. Click the arrow beside the DEBUG icon ¥ * on the workbench toolbar.
4. Select Debug from the list.

The Debug Launch Configurations window opens.

Chapter 10. Debugging a program 103



5. Select iSeries: Debug Interactive Application under the Configurations list.

Create, manage, and run configurations

Configurations:

o E Aftach to a Running Process -~
By Debug a Compiled Application

- JKT HTML Seript Application

- iSeries; Debug Batch Application

: ebug Intes Application

% iSeries: Debug Job
[P iseries: Debug Multi-Threaded Application
Java applet

- 3J Java Application

@ Java Application in iSeries Server

i 74 JavabBean

i L hd
‘I o I =

Mew | Delete |

| Debug I Close I

6. Click New.

The right pane of the Debug Launch Configurations window opens.

Nar@ [Clrt
What To Debug ] Advanced | 3§ 4| ¥

Connection: [s400a =] mew...|

—Program or Service Program

Library: | RSELAB

' Program:

fcLri

" Service Program:

V¥ Stepinto

[V Terminate debug session on program completion
@pdabe production files

Apply | Revert |

| Debug I Close I
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Name:QCLCI )

What To Debug I Advanced | 35 commen |

Connection: |5400a =] ew...|

Program or Service Program -

Library: |RSELABXX =] srowse... |

% Program:

[cuet ~]-| erowse...|

" Service Program:

I dJ Browse. .. |

v stepinto

Iv¥ Terminate debug session on program completion
Update production files

fpply I Revert I

In the Name field, type the program name CLR1 or CLC1.
Select the Update production files check box.
Click the How To Start tab.

The How To Start page opens.

Mame: | CLR1

What To Debug How To Start I Advanced | 3% Common |

Command to start apﬂica&ip:
CALL PGM{RSELABR®/CLRL) PARM{"HN")

Prompt. ..
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Narmne: |CLC1

What To Debug

How To Start Advanced I %5 common I

Command to start application:

CALL PGM{RSELABXXJCLCT)

Prompt...

10. Click Prompt.

The Call Program (CALL) window opens.

P Call Program (CALL) X
Program: CLR1 [ame
Library: RSELABXX j Mame
Parameters: "\;f() Zl
(T |
_I Remove I
Move up |
Mawve down I
I™ | advanced ™ all parameters ™ Keywords
CALL PGMIRSELABXKICLR1) PARM(%x") __:_l
@ I Restore defaults Cancel I
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11.

12.

&b call Program (CALL) X
Program: CLC1 Mame
Library: RSELABIKX | Hame
Parameters: ;| fidd |
@ o |
LI EMove
Move up |
| Mave down I
[~ advanced I~ all Parameters I~ Keywords
CALL PGM(RSELABIK/CLCL) PARM{%) -]
=
OK I Restore defaults Cancel I
2|
In the Parameters field, type 'XX'. Click Add.
The parameter value will appear in the lower list.
Click OK.
The complete start command for the program appears:
X

Create, manage, and run configurations

Configurations: Mame: I CLR1

e E Attach ko a Running Proc & |
By Debug a Compiled Applice
- JKT HTML Seript Application
i E& iSeries; Debug Batch App
= & iSeries: Debug Interactive
H & cLcl

LB am
8& iSeries: Debug Job
[ 3¢ iSeries: Debug Multi-Thre.
; Java Applet
~oE) Java Application ‘%
@ Java application in iSeries

what To Debug How To Start

Advance_‘JL

Command ta start application:
“ALL PGM{RSELABXRICLR 1) PARM{')X"

[~

-]
iy
- “ Fuun-time Workbench
- di Seript Host Applicatio
L R Sowuar

Remote Java Application

=

Prorank. .. I

o

Delete |

L

New | Loply I Revert |

—

l, Close |
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Create, manage, and run configurations

Configurations: Mame: I CLCL

o E Attach ko a Running Proc & |
By Debug a Compiled Applice
{17 HTML Seript Application What ToDebug ~ HowTostart | Advance 4|+
{5 iSeries; Debug Batch App

=% %"Ehug Intesactive Command to start application:

L Bcr CALL PGM{RSELABXRJCLCL) PARM{K) =
8& iSeries: Debug Job D&
E;} iSeries; Debug Multi-Thre.
; Java Applet

2J Java Application

- @ Java application in iSeries
- F JavaBean

- 'i-" Remote Java Application
@ Run-time Workbench ﬂ
- Jl Script Host Applicatio

n
L e Sovuar h
i I I LIJ Prorank. .. I

iz e
New | Delete | Lpply | Revert |

G|

13. Click Debug.
The Debug perspective opens.

If not, you may see this error message:

& EVFC50011 . Xl

@ Mo interactive job associated with this connection. Associate an interactive

job with this connection ko continue,
1 Cancel I <« Details I

A request to run an interactive command or program was received for the RSE d
connection s400a, but no interactive job is currently associated with this
connection. To associake an interactive job with this connection:
1. Start the iSeries communications daemon if it is not already running.
Sehect the pull down menu fram the Remote Systems view and select iSeries -
Skart Daemon
2. Open a 5250 emulator,
3. Runthe CL command STRRSESYR MAME(s400a)
4. This will associate the interactive job with this connection, causing this

The Remote System Explorer communications server has been shut down in
the meantime. Go to your 5250 emulator and restart the Remote System
Explorer communications server following the instructions in the message.
You don’t have to cancel the message. It will be removed as soon as the
connection between the Remote System Explorer communications server and
the interactive session has been established. Now the Debug perspective is
loaded in the workbench.

Now that the program is active on the iSeries and stopped at the first
executable statement, the debugger displays the source.
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Setting breakpoints

You can only set breakpoints at executable lines. All executables lines are displayed

in blue. The easiest way to set a breakpoint is to right-click on the line in the
Source view.

To set a breakpoint:

&b Debug - CLR1.CLLE - WebSphere Development Studio Client Advanced Edition for - |I:I|5]
File Edit Mavigate Search Project Profile Run  Window Help
IS -ER &% - % -%- | %-||® ¢ @~ -

|6 | mm»|A

= #5: Debug ¥ X || = Variables ) | v X
RN BRI | @ %LOCALVARS = FOR RPG, COBOL OR CL USE THE "N
’E . =@y Thread:1 (stopped) -
— = CLR1:CLR1: CLR1 1
_CL_PEP: CLRI1: CLR1
i QCMDEXC : QCMDERC : QCMDEXC 4 J i3
L= exeruteCammand @ ORSFMATN : REFMT
‘I rl » 4 i »
DebugJSefvers variableslsredq:u. l[ﬁxpres..' |Reqisters | Storage | 4 P
FECLRILCALE X l 3 Outline X
Row 1 Column 1 Replace Erows #noutling is not available,
H 1 1-———+4 —Z————4 —3————4————g————————5———
» 1 FGN  PARM{Enum) ﬂ
2 DCL VAR (&nun) TYPE(*ch
3 dcl &name *char 10
q

del &likb *char 10 -
4| | 3

g v x

TI Pr oot I B |J
—

Console | Tasks |iSeries Commands Log
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-#’ Debug - WebSphere Development Studio Client Advanced Edition for iSeries
Fil= Edit Mavigate Search Project Profle Run  Window Help

| -H8 2 || 8] %% % -%-

% -||® 2]l e-9-

|a6 | mm»|A

)= Yariables

%5 Debug

v X

LT~ x

(TS =N (e A

& | @

=@y Thread:1 (stopped)
= CLCL : CLEL : CLEL
_CL_PEP: CLC1:CLCL

qlg

@ ”‘k% | 990 ------ 3 %LOCALYARS = FOR RPG, COBOL OR CL USE THE "
-

QCMDERC : QUMDERC : QCMDEXC K |

= exeruteCammand ORQF[VIATN : RQﬂ:I
» 4

=
3

o

DebugJSefvers variable:slsredq:u. |Expres... |Redisters Storage | 4 P
RCLCLCLE X l 4= Outline X
Row 1 Column 1 Replace Erows fnoutling is not available,

1-—- -2=—- —3————+————11§;—+————5 —————
» 1 PGM  PARM{&mum) ﬂ
2 DCL VAR {&num) TYPE(*ch
3 dcl &name *char 10
4 dcl &£1likb *ehar 10

| o

4 v x

~i

= I :...nIJ

Pranomt
—

Console | Tasks |iSeries Commands Log ‘

[ [ |

1. Scroll to line 11 then right-click anywhere on line 11.

UWelome | #/MSTDSP | ZPAYROLL X |
Row 11 Column 32 Replace Browse

- 1 - 2 3-g--+ 4 : 5 : & .
S DCL VAR( &count) TYPE(*DEC) LEN(S 0O)
B CHGVAR VAR(&NAME) VALUE('Claus Weiss')
7 LOOP: chowar var [ Ecount) walue (fcount+1)
8 if (&count *ltc 100) thenigoto loop)
9 CHGVAR VAR(E&NAME) VALUE('Claus')

chovar wvar (&lib) walue |'RIELAB' *CAT &
({_Ej) CAT.T. B rpawic1in/PI¥YROLLG)
12 Edft...

&dd Breakpaint
Add Watch Breakpoint. ..

& Console [Process: 148172/RICHIEYU)Q -

Monitar Expression
Monitor Storage

Change Text File. ..
Switch Yiew 3

4

Console ] Tasks |iSeries Commands Log

2. Click Add breakpoint on the pop-up menu.

A dot with a checkmark in the prefix area indicates that a breakpoint has been
set for that line. The prefix area is the small grey margin to the left of the
source lines.
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Now you add a conditional breakpoint in the loop when it loops the 99th time.

Owekome | Zwsose [ Zpamon. [T x |
Fow & Column 31 Replace Erowse
' ' 2 ' -+ '] ' 5 ' 6—-
s LCL VAR (&count) TYFE(*DEC) LEN(E
5 CHGVAR VAR [ENANME) VALUE ('Claus Weis
7 LOOP : chorrar varlgoount) wvalue{&count+1)
- e it (ccoffint Tl 1:%[;:_"’_1@:1(:_:@
] THGWAH VER & ALUE ['Claus')
10 cherear var (&lik) walue ('RSELLE' *Ch
¥ ] 11 CALL PGM(&1ikb/FPAYROLLG)
12

To add a conditional breakpoint:

1. Scroll to line 8 then right-click on line 8.

2. Click Add breakpoint on the pop-up menu.
3. Click the Breakpoints tab.

The Breakpoints view opens:

Ereakpaints _
A Line [CLR1.CLLE:11]
W R ine [CLR1.CLLE:8]

= PN Y x

=%| Go to File

&dd Breakpoint  »

Select &ll
Il Ereble
[5 Disable

Yatiables _ =3 Remave

4. In the Breakpoints view right-click the breakpoint for line 8.
5. Click Edit Breakpoint on the pop-up menu.

rage Storage M... |Manitars |Mnd|.les | Display

The Edit a Line Breakpoint window opens.
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6. Under Views, click the *LISTING radio button.

&P Edit a Line Breakpoint ﬁl

Required information
Sets a breakpoint to stop execution at a specific source line ﬁ

Program
I *PGM RSELABXY/CLR1 =l

Module

| CLRL ;[

~Views
" *SOURCE

# * ISTING %
" *STATEMENT

Source{optional):
| CLR1.LISTING =l

Line:

—

< Back Mext » || Fish | Cancel [

&P Edit a Line Breakpoint ﬁl

Required information
Sets a breakpoint to stop execution at a specific source line ﬁ

Program
I *PGM RSELABXY/CLCL =l

Module

ICLC]. ;[
Yiews
T *SOURCE
# * ISTING
" *STATEMENT [%

Source{optional):

I CLCL.LISTING :'

< Back Mext > || Fish | Cancel
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7. Click Next.

&P Edit a Line Breakpoint x|

Optional parameters

Make the breakpoint conditional upon the Following parameters ﬁ

Thread: |Every hd I

—Frequenc
To: IW
Every: Il—

Expression: |

You only want to stop in the loop when it executes for the 99th time or more.

You can do that by setting the From field of the Frequency group to 99.
8. Under Frequency, in the From field, type 99.
9. Click Finish.

Monitoring variables

You can monitor variables in the Monitors view. Now you will monitor the
variable &count.

To monitor a variable:
1. In the Source view, double-click the variable &COUNT.

Dwekcome | Zmsose | Zpamon R X

Fow 8 Columrm 34 Replace Brouse
" 1 ' 2 ' 3-—+ 4 ' 5 ' &
4 del £1lib Fchar 10
5 DCL VAR [&zount) TYPE(*DEC) LEN(S O
[ CHGWVAR VAR [ &NAME) WALUE ('Claus Weiss'
r LOOP: chowrar wvar [ gcount) wvalue( &count+1)
L g if (w ®ir A00% rharicnts loop)
a CHGVLR EClE. "Claus')
10 chevar Edit Breakpoint. .. RSELAE' #CAT
= 11 CALL Remove Breakpoint )
Disable Breakpoint
Add Watch Breakpoint. ..

I - H A
& Console [Process: 148172/RICHIEYU/QPADEYOL .

Monitor Storage

Change Text File...
Switch View »

L
Console |Tasks |ISeries Commands Log
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| e
Row & Column 34 Replace
+ 1 + 2=-- + e — 4 + !
P 8 if ( T+ 100N +rhavn e
3 CHGVALR  Edb
10 chovar ’ n
o I cALL Edit Brea;fnlnt.
Remove Breakpoint
| Disable Breakpoint
add Watch Breakpoint. ..
TR iseries Commands Log Run To Location
54002 |
an-r-l | (e vl |
Console | Tasks |iSeries Commands Log Change Te:& File...
Swikch YView »

2. Right-click &COUNT.
3. Click Monitor Expression on the pop-up menu.

The Monitors view opens.

Debug w x | B Monitors @D@”@llﬁﬁx
o [ B 59| @ &COUNT = 00000,
= |
SRR R
£\ %
hl _.j_‘ e
Debug IServers Expres... |Registers |Storage lSturag..(IMunm}ludules | Display L
—
Welcome | Zmsose | ZpavRolL W X | 0.8 X
Row & Column 34 Eeplace Brd
t L —=d-- "3"'I+""q" ' === lan outiine is
6 CHGVAR VAR EMAME) V&LUE;I riok
7 LOOP: chorar wvar [ &count) walue available.
» 8 if t.—J
9 CHGVAR VAR(EMAME) VALUE
10 chovar wvar (&£lib) wvalue('w
4| | »
%Dsbug w X || B ponitors P
IR -~ BCOUNT = 00000,
. =@y Thread:1 (stopped) -
= CLCL: CLCL : CLCY =1
_CL_PEP: CLCI : CLC1
= QCMDEXC : QCMDEXC 1 QUMDEXC
== pweritaCammand © ORSFMATH : REFM.T
«| | »
Debuq]Servers Storage | Storag... |Monitor
B X
Fow 8 Colurm 34 Replace Erow:
; 1 ; 2 ; 3---J+ 4 } 5
> 8 if (m *lt 100) then(goto |
9 CHGVLR VAR (&NAME) VALUE('t
10 chowvar war {£lib) walue ('R
L 11 CALL PGM(&libh/PAYROLLD) =
| | »

The variable appears in the Monitors view. Its current value is zero.
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Tip: If you quickly want to see the value of a variable without adding it to the
Monitor, leaving the mouse pointer on a variable for a second or so will
display its value in a pop-up window.

Now that some breakpoints are set, you can start to run the application.

%Debug v X
)0 WA= R A e L%

CLR1 : CLR1 : CLR1 -
_CL_PEP:CLR1 : CLR1
QUMDEXC : QCMDEXC : QCMDEXC J
executeCommand : QRSEMAIN : RSEMA
main : QRSEMAIN : RSEMAIN

C nen !IORQFMQTN + RSFMATM _Iﬂ
4

i
Debug |Servers

‘ﬁv Debug * x

J? DW= 23| %
% 1@ Thread: 1 (stopped) d
Resume| .= cicr ;e act =

_CL_PEP: CLCT ¢ CLCT
QCMDEXC : QCMDEXC : QCMDEXC

[ i = axen tﬁtinn‘rna‘rl : ORSFMATN : nqjﬂ
4 »

4. Click the Resume “* icon from the Debug toolbar.

The program starts running and stops at the breakpoint at line 8. (Be patient,
the Debugger has to stop 98 times but because of the condition continues to
run until the 99th time.) Notice in the Monitors view, that &count now has the
value 99.

5. Click the Resume icon again.

The program stops at the breakpoint at line 8 again and &count now has the
value 100.

6. Click the Resume icon once more so that the program runs to the breakpoint at
line 11.

Stepping into a program

The Debugger allows you to step over a program call or step into it. When you
step over a program call, the called program runs and the Debugger stops at the
next executable statement in the calling program. You are going to step into (Step
into) the Payroll program.

To step into a program:
1. Click the Step into icon on the Debug toolbar.

: v X

SEOEINER

- 00 B &

= % CLR1 [iSeries: Debug Interactive Application] =
E @ State: <stopped:> Connection: iSeries (RORASD

F B @y Thread:1 (stopped)
=R CR1:CLRI: CLRI

_CL_PEP:CLR1:CLRL

OCMDFXC : OCMOFXC ornémncr _Iﬂ
»

i
Debug |Servers
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EEm - x
TR R EEINR

EI--% CLC1 [iSeries: Debug Inplagsetivadpplication] -
=& state: <stopped> . iSeries (ROS40(-——
[=-@y; Thread:1 (stopped)

- : 1 PFP: (101 : 101 l Ll;

The source of PAYROLLG is displayed if you stepped into RPG or PAYROLLD
if you stepped into COBOL. Depending on the option you used to compile the
program (*SRCDBG or *LSTDBG for RPG or COBOL, or *SOURCE, *LIST, or
*ALL for ILE RPG or ILE COBOL), this window displays either the Source or
Listing View.

Right-click anywhere in the Source view.

CiWelkome | #MSTDSP | ZPAYROLL x| |lo.e x
Fow 1 Column 1 REeplace Erg
1 1 1 1 a4 1 —_— ] p———
I ) 1 : 2 . 3 : B ) s An outling is
»I 1 Frtrks . l*tt*i*tﬂwﬂ nat
2 F* PRI available,
3 F= DE; AddBreakpoint rting ma:s
4 F* Add Watch Breakpaint... v descrik
5 Faawe® B ﬁﬁ‘?-‘?\‘ﬁ‘?\“-‘??—":.'
4 Run To Location .
Monitor Expression

Monitor Storage: ;
Console [Process: 148172/RICHII ? ) O Bk-8 4 x

Change Text File. ..

ld v Show *SOURCE

=
Show *LISTING =
;l Show *STATEMENT IJ

Console |Tasks |1Series Commands Log

Row 150 Column 1 Eeplace Bro-
H + 1 from o 2 o o o o e o o o % t Smmme
» 150 PROCEDURE DIVISICN. K
151 -

152 Edit...
153 &dd Breakpoink R
ll— Add Watch Breakpoint... LI—

Run To Location

E'g iSeries Commands Lo
Monitor Expression

s400a |
Monitor Storage

emmmand Tmmemat . Change Text File...
) = e TR .'

Console | Tasks | iSeries C

4 v show *SOURCE

Show E;ATEMENT
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3. Click Switch view > Show *LISTING on the pop-up menu.

Owekcone x| Zmsose | Zeavron [T x
Row 50 Column 19 Replace Browse
-——IZ————+————3————+————4————+————5————+————E————+————'?————+————B—-
489=1 i 1 1 EMPAPL
sS0=I A 2 2 FRJAPL
51=1 A 3 3 ESMAFL
52=IEMPSEL
53=1 S 1 & OEMPNO
1 | ]

Eow 320 Column 1 Eeplace Brows
B+ 1 ' 2 ' 3 ' 4 ' 5
» 380 z01 DoD1s0 PEOCEDURE DIVISION. ﬂ
391 000151 iy
392 000152 OO0O0-MAIN.

393 000153 =
«| | »

4. Page down in the source and take a look at the expanded file descriptions.

You don’t have any /Copy member in your PAYROLL program but these
would also be shown in a Listing view. Switch back to the Source view.

5. Right-click anywhere in the Source view.
6. Click Switch view > Show *SOURCE on the pop-up menu.

Listing call stack entries

The Debug view in the upper left pane, lists all call stack entries. It contains a tree
view for each thread. The thread can be expanded to show every program,
module, procedure and method that is on the stack at the current execution point.
If you double click on a stack entry you will display the corresponding source if it
is available. Otherwise the message No Debug data available appears in the Source
view.

In the Debug view, expand the stack entry of Threadl if it is not expanded already.

: >0 EN DRI R L v x
=3 CLR1 [iSeries: Debug Interactive Application]

= @ State: <stopped> Connection: iSeries (RORAS07M:5024)
= @]_. Thread 1 (stopped)
= PAYROLLG : PAYROLLG : PAYROLLG
_QRMP_PEP_PAYROLLG : PAYROLLG : PAYROLLG
CLR1: CLR1 : CLR1
_CL_PEP: CLR1: CLRL
QUMDERC @ QCMDEXC : QCMDEXC
executeCommand ; QRSEMAIN : RSEMAIN
main § QRSEMAIN : RSEMAIN
C JJE]:I QRSEMATR : RSEMAIN

QLIiMGFLW (,ELIII‘\"IGFL'u'uI QUIMGFLW
QUIMNDRY : QUIMNDRY : QUIMNDRY
QUICMENU : QUICMENU : QUICMENU

L QCMD : QCMD : QCMD

Bk Process: 145172/RICHIEYIU/QPADEYODO? Program: CLR1

Debug ‘Servers
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: w0
= CLC1 [iSeries: Debug Interactive Application]

E @? Skate: <stopped: Connection: iSeries (ROS4004:5029)
- @y Thread:1 {stopped)

. LL : PAYROLLD : F OLLD
_Qln_pep : PAYROLLD : PAYROLLD
CLCT s CLCY s CLC
_CL_PEP: CLC1: CLCI
QCMDEXC @ QUMDEXC : QCMDEXC
executeCommand : QR{{MAIN : RSEMAIN
main : QRSEMAIN : RSEMAIN
_C_pep : QRSEMAIN : RSEMAIN
QUOCMD : QUOCMD : QUOCMD
QUOCPP : QUOCPP : QUOCPP
QUICMD : QUICMD : QUICMD
QUIMGFLW @ QUIMGFLW @ QUIMGFLW
QUIMNDRY : QUIMNDRY : QUIMNDRY
QUICMENL : QUICMERU : QUICMENU
QCMD : QCMD : QCMD

The stack entry allows you to work with and switch between different programs
and/or ILE modules.

Setting breakpoints in PAYROLLG or PAYROLLD
Now you add some breakpoints in PAYROLLG or PAYROLLD.
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To add breakpoints:

1.
2.
3.

5.

Select PAYROLLG or PAYROLLD in Thread1.
Scroll to line 57 in PAYROLLG or 201 in PAYROLLD.
Double-click the prefix area of line 57 or double-click the prefix area of line 201.

A breakpoint icon is added to the prefix area of this line to indicate that a
breakpoint is set.

Repeat the above step for line 58 in PAYROLLG or 206 in PAYROLLD.

C\Welkome | ZMSTDSP | ZPAYROLL x|
Row 54 Column 1 Replace Erowse
- — 1 ' 2 ' 3 ' 4 ' 5 ' 6—-
54 C EVAL *INed = *OFF :l
55 C EVAL EMESS = *BLANK
/ 56 C EVAL EMPAPL = *BLANK—I
: 57 c EVAL PRJAPL = *BLANK
L@ a8 C EVAL RENAPL = *BLANK
59 c*
al C* Write the 3IELECT format to display. If &
61 cw
62 c*
63 C Dou not FIN6O
64 cC EXFMT SELECT
65 C TINKEC IFEQ '
v
| | » |

Repeat the above step for line 87 in PAYROLLG or 218 in PAYROLLD.
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To view all breakpoints, select the Breakpoints tab from the top left pane.

% Breakpoints = o 5P D | Ji iy - o x
A Line [CLR1,CLLE:11]

/@ Line [CLR1.CLLE:&]

A Line [PAYROLLG.RPGLE:S7]

A Line [PAYROLLG.RPGLE:SE]

/@ Line [PAYROLLG.RPGLE:57]

P ——
Varlable&_ﬁv_redq:. :‘&xpres... |Registers | Starage | Storag... |Monitc 4 P

NI v x

e

@ Line [CLOL.CLLE:S]

2 Line [PAYROLLD, CBLLE:201]
A Line [PAYROLLD. CELLE:206)
A Line [PAYROLLD, CBLLE:218]

P cam—
Variahles(Bredq:.) |Expres‘.. |Registers |Storage | 4 b

This view shows all breakpoints currently set in your Debug session. This is a
convenient place to work with breakpoints. You can remove, disable/enable,
add, or edit a breakpoint. These tasks are available from the pop-up menu
when you right mouse click in the view area. Double-click any entry to show
the source where the breakpoint is set.

Removing a breakpoint in PAYROLLG or PAYROLLD

It is also easy to remove breakpoints from the Source view.

To remove a breakpoint:

1. Scroll to line 58 and then right-click line 58 in PAYROLLG or 206 in
PAYROLLD.

2. Click Remove Breakpoint on the pop-up menu.

welcome | Zmsose | Zpavrowl x
Fow 58 Column 3 Replace Erowse
. 1 ' 2 ' 3 ' 4 ' 5 ' -
54 c EVAL TINED = FOFF &
55 C EVAL EMESS = *BLANK
56 C EVAL EMPALPL = *EBELANK—
¥ ] 57 C EVAL PRJALPL = *EBLANK
|» =a I EVAL RSNAPL = *BLANK
Edit...
Edit Ereakpoirt. .. te the SELECT format to display. If &
rec 0 l
ol -
E:;::fr:a oint " pou not *IN6O
ey Bl EXFMT SELECT
Run To Location INEC IFEQ 1 =
4 Monitor Expression | i
Monitor Storage
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Row 206 Column 1

| — 1 : )
205
2 2Nk
Edit...
Edit Breakpoint. ..

L1 WI
Disdege Breakpoint

0% iseric  Add Watch Breakpoint...

54002 | Run To Location

Monitor Expression
Monitor Storage:

Change Text File...
Switch Wiew »

The icon is removed from the prefix area indicating that no breakpoint is set on
that line.

Now you are ready to run the PAYROLLG program or PAYROLLD program.

3. Click the Resume “® icon from the Debug toolbar.

4. The RPG program PAYROLLG starts running and runs to the breakpoint at line
57. The COBOL program PAYROLLD waits for 5250 input.

5. Click the Resume icon again for PAYROLLG.
The program waits for input from the 5250-emulation session.

e 1 Session A - [24 x 80] ! =10f x|

File Edit Wiew Communication Actions il:Iu.w Help
] 2 @[ | | & @] @2

RGO 1 ] .
ele 1 15:4

1

s

v | i menected to remote serverfhost toras pd101 on psprintl:pd101

6. Type an X beside the Project Master Maintenance option.
7. Press Enter in the emulation session.

The program runs to the breakpoint at line 87 for PAYROLLG or 201 for
PAYROLLD.

Monitoring variables in PAYROLLG or PAYROLLD
Now lets monitor variables and change them in PAYROLLG or PAYROLLD.

To monitor variables:

1. In the source view, double-click the variable EMPAPL on line 88 in PAYROLLG
or 201 in PAYROLLD.
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2. Right-click the variable.
3. Click Monitor Expression on the pop-up menu.

x| || B2 outine

' Browse n outline is
Y P SRTRE- . AU
SELECT -
when - @
EXSR EMPTLG  Edit.,,
when pryapr  AddBreakpoint
EXSR PRITAC  AddWatch Breakpoint...
Run To Location
when RSNAPL
EXSR EIoMWRE  Monitor Expression
ENDSL Monitor Storage
arm
if ® TEC Change Text File...
. Swiitch View ’

Row Z01 Column 36 REeplace Bra
} 1 } ———2————+————3————+=———4————+————5——-
199
z0o IF IND-OFF ( IND-ERROR)
» 201 IF (EE g
z02 INI
4| Edit Breakpoirt...
Remave Breakpoint
= Disable Breakpoint
T iseries Commands Log Add Wakch Breakpairt...
s400a |

Run To Location

L’mmnnd |8t =t wl | IMonitor

Console | Tasks |iSeries Commands Log | Monitor Storage

Change Text File. ..
Switch View »

4. Click the Monitors tab in the upper right pane.

The variable appears in the Monitors view. Its value is blank because you did
not select the Employee Master Maintenance option.

5. In the same way add the variables PRJAPL on line 91 and RSCDE on line 113
to the monitor for PAYROLLG or line 206 for variable PRJAPL and line 244 for
variable RSNAPL for PAYROLLD.

Variable PRJAPL equals ‘X" because you did select the Project Master
Maintenance option.

6. In the Monitors view, double-click the variable RSCDE for RPG or RSNAPL for

COBOL.

The value changes into an entry field.
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7. In the value field, type in the new value X for the variable.

B onikors

=8 HBS x

oy BCOUNT = 00100,
-9 EMPAPL =
-9 PRIAPL =X
ERENF S CDE = 3

Breakp... |Expres.. |Registers Storage |Storaqd... |Munitors]Mnd.|Ie4 »

B =8 5| Ba x
(3 BCOUNT = 00100,

(3 EMPAPL =

) PRIAPL=X

Expres... |Redisters |Storage |Storag.., IMonitors |I 4

Press Enter.

The variable is successfully changed.

Adding a storage monitor
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Adding a storage monitor for a variable allows you to view the storage starting
with the address where the variable is located. The storage is displayed in

hexadecimal and text format.

To add a storage monitor:

1.

In the Source view, double-click the variable ERR in line 33 for PAYROLLG or

IND-ERROR in line 219 for PAYROLLD.

Right-click and select Monitor Storage on the pop-up menu.

Owelcome | Zmstose | Zeavmow. RS X |
Row 33 Column 21 Replace Brouse
B T . P T T - T -
Z5 F* - RENMET - reason code mastcer f:l
26 F‘K‘XTtTK‘XT‘}:TKTTtT'XW‘.\"?:T'KT:I‘X'KT:I‘X'KT:Z‘Xﬁ“&'a".’.‘xﬁ“ra".’._l
27 FMSTDSP CF E WORKSTN
28 FEMPMET UF 4 E K DISK
29 FPRINST UF A E K DISK
30 FRENMST UF 4 E K DISK
31 D*
32 I* Compile time array containing error descr
33 ) ERCEE & 50 DIN{10)
34 p Er Edt. 50
35 Er Add Breskpoint
36 C‘R‘X: A e e e e e o e
Add Watch Breakpoint... =
‘I Bun To Location I—I d
Monitor Expression
Console [Process: 148172/R. pume s— LR1]
Ll Change Text File...
Switch Yiew »

Console lTasks |iSeries Commancseoe
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A new page is added to the Storage view. The tab shows the name of the
variable.

il s

ERR : Thread 1 ]

Address

C540D5D6E

E77F4040

D6D5CS540
CFF2DF2 60500544 i E2C5D3C5
CFF2DF260900B45 - - DSE3C5D5
CFF2DF260900B46 (& Copy Yiew to Clipboard C1D7D7D3
CFF2DF260900B47 o C3E3C5C4
CFF2DF2 60900848, S It View C1D5C3C5
CFF2DF260300B430 40404040 40404040 42040C1C3 E3CSD6DS
CFF2ZDF260900B4A0 40C3D6C4 C540D5D6  E340C5DE  E4C1D340

CFFZDF260900B4EB0 E3D6407F C1l7FebB40 7FC37F40 DeDS407F
CFFZDF260500B4C0 C47r4040 40404040 40C1C4C4 40DSCSDS
CFFZDF260900B4D0O E4CS5EZES CS5C440CZ E4E340D9 (CSC3D6DO
CFFZ2DF260900B4EQ C440C1D3 DSC5C1C4 EB40C5E7 C9EZE3E2

IND-ERROR : Thread 1 |

Address o - 3 4 - 7 8 - B

CEADOZFBzZDO0Z2ZCC 4B0000S0 Q0000000 00000000
CEADDZFB2D0O0Z2DC 00000000 00000001  FOOOOOOO

CEL00ZF82DO0Z2ZEC 00000000 OO07FFOFL  FOFLFOF1
CEADD2F82D0O022FC 00000000 4040FOF0 40204040
= : 4p Monitor Expression 1203040
CELONZFB2DO02E 404040
C64002F8zD0o0z: = Remove Storage Monitor 404040
CEADD2F82D002 0 Mo Iquququ

CoAOOZFBZDO0OZZ Content S 404040
CELO0D2F82D0023 000000
C64002F82D0027 [ Copy View to Clipboard 404040
CeA0OZFE82D0O0ZE apﬂnt iew 404040

CEADOZFBED0O0Z3TC  F0H090F0  sos03090 - 30404040

3. Use the scroll bar on the right of the Storage view to scroll down.
You can see the current content of the memory.
4. Right-click in the view area.

5. Click Reset Table to Monitored Address on the pop-up menu to return to the
starting address.

6. Right-click the view area.

7. Click Remove Storage Monitor on the pop-up menu to remove the storage
monitor.

Setting watch breakpoints

A watch breakpoint provides a notification to the user when a variable changes. It
will suspend the execution of the program until an action is taken.

To set a watch breakpoint:
1. Click somewhere in the Source view and press Ctrl+L.

A Line number field is added to the bottom of the source area. In this field
type 116 to go to that line in PAYROLLG or 118 to go to that line in
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PAYROLLD.

welcome | Zmsose | Zpavrowl x
Row 56 Column 1 Replace Erowse
. P D Y DI T T PO Y -
53 C dou * TNKC N
54 C EVAL #*INeD = *QFF
55 C EVAL EMESS = *BLANK—)
568 c EVAL EMPAPL = *BLANK
5 ] a7 C EVAL PRJALPL = FELANK
58 C EVAL RENAPL = *ELANK
58 cw
&0 C* TWrice the SELECT format to display. If &
61 c*
62 c*
63 cC DoU not *INGO =
«| | L|J
e number: ftiel 2

O x |
Row 201 Colummn 18 Replace Erow:
" 1 g---2 ' 3 ' 4 ' 5
- 2%. IF (EMPAPL OF SELECT-I = 'X:l
202 INITIALIZE EMPSEL-OQ —

L d

«| | »

Line number: | 118]

Double-click variable *IN60 in PAYROLLG or IND-TABLE in PAYROLLD to
highlight it.

Right-click and click Add Watch Breakpoint on the pop-up menu.

The Add a Watch Breakpoint window opens. The Expression field is pre-filled
with the highlighted variable *IN60 or IND-TABLE. By default the Number of
bytes to watch field is set to zero, which means the variable will be watched in
its defined length.

&P Add a Watch Breakpoint x|

Required information
Sets a breakpoint to stop execution when data changes at a specific address ﬁ

Address or expression: | INE0
Mumber of bytes to watch: [0 =1

< Batk Mext » || Fish | Cancel
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4B Add a Watch Breakpoint EE X|

Required information
Sets a breakpaint to stop execution when data changes at a specific address ﬁ

Address or expression: | iNIZfTABLE

Mumber of bytes to watch: |U ﬂ

4. Click Finish.
The watch breakpoint is now set.
5. Click the Resume icon on the Debug toolbar.

The application waits for input from the 5250-emulation session.

e 1 Session A - [24 x 80] =10f x|

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] (%) 2 3| @

v | i :Cc-nnected to remote server/host toras pd101 on psprintl:pd101

6. In the 5250 emulation session, type 123 for Project Code and D (for delete)
the Action Code field.

7. Press Enter. A message is displayed indicating that the variable *IN60 or
IND-TABLE has changed.

&b Debugger Message . Xl

i VYariable *IN60 has changed in program PAYROLLG, module PAYROLLG, which
\\I) is running in job QPADEYODOT/RICHIEYL [148172,

&P Debugger Message x|

/"= Yariable IND-TABLE has changed in program PAYROLLD, module PAYROLLD,
\\I) which is running in job QPADEYODOF/STECKHAM (173708,

in

8. Click OK. The program stops at line 465 in PAYROLLG or 407 for PAYROLLD.
This line is located immediately after the statement which caused the variable

*IN60 or IND-TABLE to change.
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Closing the debug session

To close the debugger:
1. Click the Resume icon on the Debug toolbar.
The application waits for input from the 5250-emulation session.
2. Switch to the 5250 emulation session.
3. Press F3 to end the job.
A message Program terminated appears:

-ﬁa Debugger Message ll

@ Pragram terminated.

4. Click OK.

File Edt Source

Debug |Server

5. Right-click the Debug icon on the left task bar of the workbench.
6. Click Close on the pop-up menu.

Checkpoint
Complete the checkpoint below to determine if you are ready to move on to the
next module.
1. You can start the debugger:
a. From the Remote Systems view
b. Launch Configurations window
c. Both
2. You can only set breakpoints at executable lines. (T, F)
3. The easiest way to set a breakpoint is to:
a. Right-click on the line
b. Right-click after the line.
c. Right-click before the line
d. All of the above
4. You can change variables and indicators in the:

a. Remote Systems view
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Debug view

Monitors view

Storage view

. All of the above

5. The debugger allows you to:

® 20 o

a. Step over a program call
b. Step into a program call C
c. Both

6. The Debug view lists all call stack entries. It contains a tree view for each
thread. (T, F)

7. You can perform which actions on breakpoints:

a. Delete
b. Add
c. Disable
d. Enable
e. Edit

f. All of the above

8. Adding a storage monitor for a variable allows you to view the storage starting
with the address where the variable is located. (T, F) 9.

9. The Storage monitor supports these display formats:
a. Hexadecimal and character

Character only

Decimal

All of the above

. Aand B

10. A breakpoint provides a notification to a user when a variable
changes. It will suspend the execution of the program until an action is taken.

a. Watch

® 20 oT

b. Support
C. Java Exception
d. Type

More practice

Want more practice? Try this!

Given your experience in working with the debugger features, in your own source,
try setting, changing, deleting, enabling, disabling line breakpoints, setting watch
breakpoints, displaying and changing variables and viewing the call stack as you
debug your program. Use the Development Studio Client online help to assist you
in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:

* The purpose of the Debug view, the Monitors view, the Storage Monitor, the Call
Stack and the roles of different types of breakpoints

* The actions you can perform on breakpoints

Chapter 10. Debugging a program 127



* How to start the debugger

* How to set breakpoints

* How to monitor variables

* How to run and step into a program

* How to view the call stack in the Debug view
* How to remove a breakpoint

* How to add a storage monitor

* How to set watch breakpoints
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Chapter 11. Module checkpoint answers

2 3 4 6 7 9 10
1d 1b 1c 1d 1d 1b 1c
2e 2aa,bd,cb, 2e 2T 2d 2aa,bb,cd,dc |2T
ee
3f 3a 3g 3e 3e
4c 4T 4T 4h 4c
5T 5d 5T 5¢
6e 6¢ 6T 6T
7e 7b 7T 7e
8c 8T 8T
9¢c 9T 9a
10a 10a
11d
12¢
13F
14d
15e
led
17d
18b
19T
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM

iSeries
0S/400
RPG/400
VisualAge
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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